ZCP 7.1 (build 43630)

/arata Collaboration
Platform

The User Manual

& Zarafa




Zarafa Collaboration Platform

ZCP 7.1 (build 43630) Zarafa Collaboration Platform
The User Manual

B 2.0

Copyright © 2014 Zarafa BV.

The text of and illustrations in this document are licensed by Zarafa BV under a Creative
Commons Attribution—Share Alike 3.0 Unported license ("CC-BY-SA"). An explanation of CC-
BY-SA is available at the creativecommons.org website*. In accordance with CC-BY-SA, if you
distribute this document or an adaptation of it, you must provide the URL for the original

version.

Linux® is a registered trademark of Linus Torvalds in the United States and other

countries.

MySQL® is a registered trademark of MySQL AB in the United States, the European Union and

other countries.

Red Hat®, Red Hat Enterprise Linux®, Fedora® and RHCE® are trademarks of Red Hat, Inc.,

registered in the United States and other countries.

Ubuntu® and Canonical® are registered trademarks of Canonical Ltd.
Debian® is a registered trademark of Software in the Public Interest, Inc.
SUSE® and eDirectory® are registered trademarks of Novell, Inc.

Microsoft® Windows®, Microsoft Office Outlook®, Microsoft Exchange® and Microsoft Active
Directory® are registered trademarks of Microsoft Corporation in the United States and/or

other countries.

The Trademark BlackBerry® is owned by Research In Motion Limited and is registered in
the United States and may be pending or registered in other countries. Zarafa BV is
not endorsed, sponsored, affiliated with or otherwise authorized by Research In Motion
Limited.

All trademarks are the property of their respective owners.

Disclaimer: Although all documentation is written and compiled with care, Zarafa is not
responsible for direct actions or consequences derived from using this documentation,

including unclear instructions or missing information not contained in these documents.

The Zarafa Collaboration Platform (ZCP) combines the usability of Outlook with the
stability and flexibility of a Linux server. It features a rich web-interface, the Zarafa
WebAccess, and provides brilliant integration options with all sorts of clients including
all most popular mobile platforms.

* http://creativecommons.org/licenses/by-sa/3.0/



http://creativecommons.org/licenses/by-sa/3.0/
http://creativecommons.org/licenses/by-sa/3.0/

Most components of ZCP are open source, licensed under the AGPLVBl, can therefore be
downloaded freely as ZCP's Community Edition®.
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discusses:
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Introduction

The Zarafa Collaboration Platform (ZCP) combines the usability of Microsoft Outlook and
Exchange with the stability and flexibility of a Linux server. It features a rich web-
interface, the Zarafa WebAccess, and provides brilliant integration options with all
sorts of clients including all most popular mobile platforms. Most components of ZCP are
open source, licensed under the AGPLv3, can therefore be downloaded freely with ZCP’ s
Community Edition.

Several closed source components exist, most notably:

+ the Zarafa Windows Client providing Outlook integration,

+ the Zarafa BES Integration providing Blackberry Enterprise Server connectivity,
+ the Zarafa ADS Plugin providing Active Directory integration, and

+ the Zarafa Backup Tools.

These components, together with several advanced features for large setups and hosters,
are only available in combination with a support agreement as part of ZCP' s Commercial
Editions.

Alternatively there is a wide selection of hosted ZCP offerings available.

This document, the User Manual, describes how to use ZCP from a user s view point.

1.1. Scope of this document

This manual is intended for users of the Zarafa Collaboration platform. Users interact

with this platform by several means:
* Microsoft Outlook and the Zarafa Windows Client,
+ the Zarafa WebAccess, our open source web-based groupware solution, and

+ various mobile platforms like: BlackBerry, Google Android, Windows Mobile and Apple
iPhone.
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Using the Zarafa WebAccess

In this section we describe how to use the Zarafa WebAccess, the web-based interface of
the Zarafa Collaboration Platform (ZCP).

In order to use the Zarafa WebAccess a fairly recent version of Mozilla Firefox

(preferred) or Microsoft Internet Explorer is needed.

Currently the Zarafa WebAccess supports the most used features of Microsoft Outlook in a
fairly comprehensive way. Yet a web-based interface can never match the functionality and

usability of a native client (like Microsoft Outlook).

2.1. Basics
To login to the Zarafa WebAccess, point the browser to the URL supplied by the systems
administrator. By default this URL will look like:

http://YOUR_DOMAIN NAME/webaccess/

The WebAccess is available in several languages which can be selected from the dialog

shown on 2.1 “The Zarafa login screen”

& Zarafa

Outlook sharing & Webaccess

: WebAccess ::

Please logon.

Marme: | | |

Paz=ward:

Language: | Last uzed language w |

End AnacA
2.1. The Zarafa login screen

After logging in, all Outlook folders and the Public folders the account has access to
can be accessed. The most basic functions are available from the WebAccess' toolbar found
across the top of the page. See 2.2 “The “New” Menu” .

“
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With regards to the folders, some functionality is only available in the context menu

that appears when right clicking on

the folder items.

¢ Zerafa webaccess

) Email Mezsage

& Distributionlist
@ Tazk
28 Note

| ® Folder

ﬁ Appointment Test
[ hieetingrequest

§2 Cortact ms

2.2. The “New” Menu

2.2. Managing folders

Creating, moving, renaming, copying or deleting (sub) folders is accomplished with the
right mouse button in the folder 1list. This pops-up a context menu as shown in 2.3

“The context menu of a folder”

Folder list m

All folders

|Fr|:|m

= &f’ Inka -

@ Calendar

Lucas Test 3]

@ Contacts
@ Deleted tems
\..f Drafts

2 fald

=

Jau
8 Jun
2 Mot

3 Out

= Cpen

L™ CopyMiove Folder
EIRename Folder

4 Nevwe Folder

RS

,
_x Ser

[y Mark Al Measages Read

ﬁt‘l Tasy

A Delete Folder

COpen

Properties

2.3. The context menu of a folder

It is not possible to delete, move, or rename default Outlook folders (like Inbox,

Calendar and Contacts) .




Printing

2.2.1. Printing

It is possible to print email, appointments, and contacts from the WebAccess. Simply use
the Print button from the toolbar.

Following these steps it is also possible to print calendar overviews of a day, a week or

a month.

2.2.2. Resizing panes
Just like in Outlook it is possible to resize the panes in the WebAccess, allowing full
control of the width and height of the workspace in each pane. To do so place the mouse

between two panes en drag the pane border to the prefered location.

2.2.3. Empty deleted items folder

The Deleted Items folder can be emptied by using the right mouse button, and selecting
option Empty folder from the contect menu. This option is only available from the context
menu (accessed with the right mouse button) of the Deleted Items folder and the Junk Email
folder (if it exists).

2.2.4. Restore items

When deleting an item in the Deleted Items folder or the Junk Email folder, the item is
still temporarily recoverable. Select the Deleted Items folder or Junk Email folder, and
use the button Restore Item in the bar at the top. As shown in 2.4 “The soft delete
restore window” it is possible to restore all or a selection of the deleted messages or
folders. The restored items will be moved to the old location. Deleting items from 2.4
“The soft delete restore window” removes them permanently — in that case only backups

can recover an item. When restoring a folder, only that folder will be restored. If the
restored folder contained subfolders, these can be restored by selecting the just restored
folder and clicking on the Restore Item button again.

Restore deleted ltems

“Restore _"{Restore All| 3 Permanent Delete 3¢, Delete All| PClose |
AR 5 SRR

|  |From | Subject Deleted on Size

| junk1 11-09-2008 2kb -
| junk2 11-09-2008 Zkb

| good mail 11-09-2008 Zkb

2.4. The soft delete restore window

2.2.5. Marking all messages in a folder as read

Marking all messages in a folder as ‘“read” 1is accomplished by the right mouse button
menu option Mark All Messages Read. Please note that when this option is selected, no read
receipts will be sent when requested by a sender, even if that option is selected in the
settings.
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2.2.6. Properties

The right mouse button menu option Properties shows additional information about a folder
(1ike the storage size and the number of items in this folder). For more details about the
storage size, use the button Folder size-:--. Here a list containing all subfolders in the

folder including their individual storage sizes can be seen.

2.3. Access to folders and calendars for other users

Just 1like in Outlook, the WebAccess allows sharing permissions to be set on folders. To do
so use the right mouse button to click on a folder and choose the Properties option, then

select the Permissions tab as shown in 2.5 “Folder Permissions”

BT 000 i
Avew - % & | aRey g m——
— _

All falders & E
=] @,m o rit wan ons
I+ @ Calendar | Fermissions ]
@ Contacts
i @ Celeted tems
.a-] Draftz
= [ zoft - Linux
3 Open - Linux
B - Mew Fald Add.. | Remove | Btatus hericht
o o hew Folder —Permissions ot - Linux
iR (3 Mark Al Messages Read Profile: Onlyread = bericht
g . Btatus bericht
= Properties g P
) 2 I Create items I Folder permissions Line
= E5 public folder ¥ Read tems V! Falder wisible = bericht
™ create subfalders - Lirux,
Ediit tems Delete items = bericht
« Mone « Mone
C oun “ own G
. Al . All
Ok I Cancel I
. [% Done apachef2,.0.59 @&
T

2.5. Folder Permissions

2.3.1. Add a person
Click on the Add button under the Permissions tab.

When the Address Book pops up, select the person to give permissions to and click Ok. This

contact will then be added to the permissions 1list.

Please note that this persons' permissions must be changed. As by default the dialog

grants no additional permissions.




Change permissions

Click Ok to save and close the permissions window.

2.3.2. Change permissions

Click on the person whose permission needs to be changed.

Now the permissions can be manually set in the bottom part of the permissions window, or
one of the preset profiles can be selected from the Profile drop—-down menu.

Click Ok to save and close the permissions window.

2.3.3. Remove a person

+ Click on the person who needs to be removed from the list.
+ Click on the Remove button.

+ Click Ok to save and close the permissions window.

2.3.4. Open shared folders

To open shared folders from the Zarafa WebAccess click the Open shared folder link at the
bottom of the folder list. A window as shown in 2.6 “Open Shared Folder” will be
presented.

Open Shared Folders

[ Marme... ” |
O a1l folders
® | Inbax V|
[ Ok ] [ Cancel ]

2.6. Open Shared Folder

From the dialog shown in 2.6 “Open Shared Folder” it is possible to either open
a single folder (for example the calendar folder), or open a complete folder list of a

specific user.

The opened folders are stored in the users' WebAccess profile, so the next time the user
tries to login to the WebAccess the opened folders are readily available.

To close an opened folder, use the Close store option in the right mouse button menu.

2.4. Email

2.4.1. Compose and send a new email

1. Select the button New in the left corner. This will show a dialog like 2.7 “Create
Mail” .
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Creats E-Mall

I_ Ta.. | ||.|eliﬂ’z,d =laian

I_ L. | |l.cd~r@cdd ERRL ]
LU . |
Sare e v ppirimert
[ roschrens |

(R 7 H el x oW [IZiE EE]

: lamat [Howa ook e fo=

MNeatr =

2.7. Create Mail

Attachments can be added to the email by selecting the Attachment button or the
Paperclip icon.

Email can be saved by selecting the Floppy disk icon. After a email is saved, it is
stored in the Drafts folder.

To set a flag that marks the email as important or high priority, click on the
exclamation mark (!) icon.

To add a recipient, either add their email address in the TO, CC, or BCC field
manually, or select a person from the Address Book. To access the Address Book, click
on the TO, CC or BCC button.

When more than one recipient is added, email addresses need to be seperated by a
semicolon (;).

The internal users are shown by default (unless otherwise selected in Settings) in the
Address Book (see: 2.8 “Address Book” ). By using the Show names from the: drop-
down menu, it is possible to view contacts from either a personal contacts folders,

or a Public contact folder. Alternatively, it is possible to search a folder using the
search field positioned in the top left of the window.




Compose and send a new email

Address Book

Type Hame: Show names from the:

| ) : [Global &ddress Book
Global Address Baok

[ |File a= Display Mame Cantacts

7 Algjandro Algjandro Test Algjandro@unt! mtestnl A
@E‘.‘: Al Alex Test Alexi@unit1 ztest.nl =
gﬁ.} Alexander Alexander Test Alexanderi@unit! .ztest.nl F
@E‘,‘: Ancel Ancgel Test Angeld@unit! .mtest.nl

@E‘.‘: Blake Blake Test Blakei@unit1 ztest nl

@}'.‘: Caleb Caleb Test Calebi@unit .ztest.nl

@j;'.‘: Carlos Carlos Test Carlos@unit1 . ztest.nl e
[ To... ]

e —

|  Bco. |

[ Ok ] [ Cancel

2.8. Address Book

Since 6.30.0 it is possible to add company-wide defined address lists in the Address
Book. Read the ZCP Administrator Manual for more details regarding address lists.

2.4.1.1. Automatic email address suggestion

When typing an email address or contact information in the TO, CC or BCC fields the
WebAccess automatically suggests names (a feature often known as auto complete). The
suggestions are listed below the input field (see: 2.9 “Automatic Suggestions” ) and
a suggestion can be selected by both mouse or keyboard. The suggestions are based on email

addresses and contact information that have been used recently.

It is possible to delete an address from this list by moving the selection to the address
in question (by either using the keyboard arrows or by placing the mouse over it without
clicking) and then pressing the Delete key. The address is removed, but when it is used

again it will show up in the list once more.
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pe==—— ]
end B & | & & ¥ & |9 Dslicns |

| b
____J hlllllllllllllllllllll
_oce.. |

oany oEEarefa.com < oo zarefa con

Jolm Zerafa -ioln carssiEzarais.cor-
Subjact

2.9. Automatic Suggestions

2.4.1.2. Attachments

You can attach files to your message by clicking the Attachments button in the Create E-

Mail screen. A window will open, which allows files to be uploaded.

From ZCP 6.50 up it is possible to upload multiple attachments at once. Prior versions of

ZCP only allow the upload of one file at a time.

To upload multiple files at once, Adobe Flash has to be installed in the browser.

2.4.1.3. Set the sender address (from field)

It is possible to set the FROM address of emails before they are sent. This field can
be found above the TO field, as shown in & 2.10 “Selecting a from address” . When no
address has been selected the default address is used.

ck-et B & | 8| 0 & B o]

e :l
g Janc Cos jrcoos=oy sl oo
LL.. Jar Cas q:ﬂr-:oec"'mmaclm St

arr |

2.10. Selecting a from address

Please note that the FROM field is only displayed when FROM addresses have been set in
the settings dialosg.

=From Email Addr
2 FROM er i3l addresses

Janz Dioe ¢ jansdce@zar=fe.comnz =+

[l Tk <jubenh T R R R IR RILE

2.11. Adding From Addresses

10



Inline images

Please contact the systems administrator, if the following (bounce) message is

returned when sending from a different sender adress: You are not allowed to send as
the given user.

Since ZCP version 6.20.0 two kinds of delegation are available:

1. Send on Behalf permissions: if a user grants the appropriate permission to another
user, the latter can send items on behalf of the other user. In this case an email or
meeting request will be sent with the following From field: “<delegate> on behalf of
<user>"

‘

2. Send As permissions: if the system administrator gives the rights to user B to
send as’ user A, the receiver of an email will not see that user B sent an email. The

receiver will only see user A in the From: field.

Before ZCP version 6.20.0, user themselves where allowed to “send on behalf of” by
entering the other users inbox. By this method it was always explicitly visible who sent
the email. For example: Pete enters the inbox of ‘info’ and sends an email as the non-

. ‘. ) .
active user info , would result in:

pete@example.com on behalf of info@example.com.

13

Since ZCP version 6.20.0 it is possible to send emails as other users without the
on behalf of” part. Due to security reasons the new “send as” permission is only
configurable server-side by the administrator. This setting can always be overruled by the
user itself and the old “on behalf of” permission can still be set by the user.

Keep in mind that delegation always overrules impersonation. A user can always choose not

to let another user impersonate as himself.

2.4.1.4. Saving an email to drafts

Saving an email is possible by clicking the Save (a floppy disk) icon. After saving the
email, it is stored in the Drafts folder. Another option is to automatically save an
unsent email. This option is available under the Compose Mail tab in the settings window.
To do this, check the option Autosave unsent every: X minutes and set the number of
minutes that mails will automatically be saved. This is only applicable when the email

isn’ t sent vet.

2.4.2. Inline images

From ZCP version 6.30.0 the WebAccess has the ability to add inline images in mail
messages. To add an inline image, click on Attachments and select an image. If the °

HTML’ format is being used (see Compose mail in this format in Settings, Compose mail
tab), the inline image functionality is enabled. A light blue cross icon will appear

beside the attachment as seen in 2.12 “Light blue cross icon to insert the image as
a inline image” . Click on the blue cross icon to insert the image in the mail body as
shown in Eﬂ 2.13 “Example of an Inline Image” . The inline image will inserted at the

last cursor position.
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Create E-Mail

| gsend | B) & | 2/8.] 8 8 Soptions|
—To... o
:

BCC.. [

Subject; Irline image

[Whster liies g (32kh); 0

PR T I oshelx e ]ii=

: Format [Momal [+] Fant | | Size [

| ‘un ¥ @) ‘

2.12. Light blue cross icon to insert the image as a inline image

Create E-Mail

lse B2 Bel b bl ool

s

[

BLLC.. [
Subject: :.Inline @mage

Aftachments: | | 3

w
LN
5 |

LB s mdeix ol b

: Formnat | Normal [~ Fant | ~ | Size

2.13. Example of an Inline Image

To change the image size, right click on the image and select Image properties. A popup
like 2.14 “Image properties editor’ will appear which enables the user to customize
width and height of the image and options such as border and alignment.
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Copy, move and delete email

‘Image Properties
k|

Image Info | L

URL

|.fanand.finIineimg.r'|:|hp-webclient-aiaﬁ.finde:-:. |:|hp?IDaI:I=I:IDwnlaad_attachment&diala|

Alternative Text

Freviewm

‘width (403
Height | 302

A.

i O

Border
HSpace

WSpace

Align L

2.14. Image properties editor

It is possible to delete the inline image directly from the main body, as if it were text.

In some browsers it is possible to paste an image from your clipboard directly into

the editor. This will embed the image into the source of the body and it means that it
will not become an attachment. The image will be shown properly in Firefox and Internet
Explorer 9, with limited support in Internet Explorer 8. In Outlook the image will not be
visible properly.

2.4.3. Copy, move and delete email

The following screenshot (& 2.15 “Context menu from a mail message” ) shows the context
menu that shows up when clicking with the right mouse button on an email. Through this
menu most copy, move and delete operations are performed. It also is possible to download
a message as a file.

R ——

o dew = WO & | il Recl G Reck A g Furmad

Folder hist Inbox
Al Tuedas oy il | L) |[§|i'|'mm |3.h'|_-:|
=1 €& nbm - Aexande: Toat e i
H Calmnde = o 1 F.c tipen lagtatya
& ol 2 g DPEA s Pt Adlactio
A {J Doizied tora i ERET i e Al
o nranx = H=mic ¥ 41 KL v
:Imjlm A Munng Gl P A Pt e 1
& zunpot I SECrH 22
"w‘a-. “mirnnl ] ek Wonirded
ok e o Wark Jroead
L‘:‘ Hotes Cahgark=
U by
L Fen: beos ¥ Rcd Sog
. .qj Tazle wr Flay Guplale
ﬂ&wnmm-nn- —
e
@ Tavarbes Deise Mag
3 pusk: Fullee Am:'_h'd }( Liej=ie
[ [EEERH T FAW =R

2.15. Context menu from a mail message
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2.4.3.1. Delete email

There are several ways to delete email. They are:
-+ Via the delete button on the keyboard

- Via the delete button in the right mouse button menu (as shown in 2.15 “Context menu

from a mail message” )

- Via the red cross button in the top bar of the webaccess

2.4.3.2. Move email

To move a single items it is most convenient to simply drag the item to its new location.
Place the mouse cursor over the item to be moved, click and hold the left mouse button.
Continue to hold the button down while moving the mouse cursor until it is over the folder

the message needs to be placed.

LA VDS s

o Mewe - | i | ol Reply o Reply 201 g Forward |

Folder list
Al folders
= %‘ Inbox - ...

3 Calendar ) ' B . ey ez e
=2 contacts o 2 durceishl - T winnen ki speurdss -

9 e — .

'
:

| & |From

Speurders nl

winnen bij speurders.nl

\.J Drafts
2 @ [Nk

Journal

8 Jurk E-mail (68)

Motes

33 Outhax

;;: Sent tems

@ Task=s

2.16. Moving Email

U 0 | 0 | B 5 o |

Notice that the folder names under the mouse cursor are highlighted while moving. This
highlighting marks the folder where the message will be placed when releasing the button.

To move multiple items, first select all the items (only items that are currently visible
can be moved). To select a range of items click on the first item and then press and hold
the shift button on the keyboard. Before releasing the shift button, use the mouse to
click on the last item in the range that needs to be moved. All items between the two

items clicked on will become highlighted.

With items that are not consecutive, hold down the control (Ctrl) button on the keyboard
while clicking on each item. To drag and drop these items, release the control button,
place the mouse cursor on one of the selected messages, drag them into the designated
folder.

Ttems can also be moved by clicking on the copy/move button as displayed in 2.17
“Copy/Move Button”

It is also possible to drag and drop messages to the desktop. For more information about
ERn

this feature, see & 2.14.1 ¥ “Zarafa Attachment Drag ‘n’ Drop Extension”
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Copy, move and delete email

2.4.3.3. Copy email

To copy an item, the drag-and-drop feature can not be used as it does not duplicate items.
Instead use the copy/move button as shown in [& 2.17 “Copy/Move Button” . See the section
above about moving multiple items for an explanation concerning how to select multiple
items.

¢ Zarafa Webaccess

cmew v | ¥ U = | dRenly Reply Al giForward

All folders |me

2.17. Copy/Move Button

2.4.3.4. Save Email as a File

From ZCP 6.50 up, it is possible to download messages directly from the Zarafa WebAccess
to the computer. The Save Email as a File button located in the message context menu, as

seen in 2.18 “Save Email as a File button” , should be used to do so.

[ Open

Adz=m Test . . 506
[&) save Email As a File

] ¥

RE: test
=, Print

Codv kolenboer - 5:05

2.18. Save Email as a File button

2.4.3.5. Change email view

BT A = igl Pepk gl Peph &1 g Forwerd

FTRE R [l DEE. T el
= =\ - IT"”""I"' [T L
=R bk - el Tood I AL .
8 Cajanda- E] Ao Vst ] et dessendn: Roppaac
“5::':- Conlazs S OPFAN | et s coln [ONOE OGS
L I =] el ik B il o
A Lt wl  temconf & e Lhooser ETRpE=EReee]
= [T 4 & Mermar malline Parcncr aloumske ot o

2.19. Context menu form a mail view column

In the Zarafa WebAccess, the email view has a default layout: a list of messages with a
From and a Received colomn. However, like in Outlook, it is possible to change the view by
adding or removing columns. To do so, use the right mouse button to click on the header of
the list (for example on the From header field) and select the Field Chooser option from
the context menu. A dialog that looks like 2.20 “Field Chooser” will pop up.
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Field Chooser

Available fields:

2.20. Field Chooser

Additionally,

Categories
In Falder
Modification
Sent

Ta

Add B

4 Delete I

Selected fields:

Priarity

lzon
Attachments
Fratm
Subject
Feceived
Size

Flag Status

ok J |

Cancel ]

default email is sorted by the Received date column.

2.4.4. Searching

To search click the Search button in the tool bar. A seach bar (see: 2.21
Options” ) will then be added to the WebAccess view (to remove the search bar, click the

Search button again).

FTAN W ————

Hnew - WY &
Folder list
Al folders

= @)’ Inbox -

@ Calendar
@ Contacts
@ Deleted tems
' Dratts

=
Journal
# Junk E-mail
Motes
3% Outhax
_w;: Sert kems
@ Tasks

" Trash

&l Reply gl Reply 21 &gl Forward

it is possible to sort the email 1list by selecting a specific column. By

“Searching

2.21. Searching Options

%
Inbox [10r5 |- 4]
Search | Subject or Sender 'l for I Search Clear |
LN |% | Subject |Received * |size | %
@ Elody Thanks for joining Firefox Add-ons Fri 050407 08:52:02 Skh i .
Subject ar Sendar Schrijf uin woor TechMet Live op 18 juni Thu 050307 16:08:25 118Kk i
- Toorce TechMet Flash: Windows Server "Longhorn” Beta 3 s Here Thu 05/03/07 06:41:11 322kb W
-] aclminiztrad er r Betaling on gen! i3
@ The ¥hware Teatmn YMwarld: Save the Date, September 11 - 13 wyied 050207 10:15:05 24kb W
8 STARTREK.COM TG at 20, Star Trek convertion news, Doohan memorial and morn Tue 050107 20:04:17 S8kh 4
@ service@bigdennis com Koninginnedag, en BigDennis .com viert meel Sat 0452807 14:10:04 kb W
oy P Fri 0427107 03:31:26 S4kh I
@ Speurders.nl Dit il Jj toch ook? Thu 04726107 11:46:33 18kb W
= Inmac Migumy TOMTOM One KL WWied 0425007 13:43:51 19kk I
=) Microzoft Wicrozoft MSDN-nieusyshrief wied 0472507 12:53:34 95kh U
S e EQ Primmma o L e ettt Tom AAFIANT AT 4. 47 Sdll r LI
The seach bar allow a user to enter a search query and choose where to search. For example

if a user remembers just a part of a message’ s subject he can select Subject from the

pull down menu. After the query is keyed in the user should click the Search button

(binoculars icon) on the seach bar, or press the enter on the keyboard. As shown in

2.22

“Search Result” , the email list is updated with the results of the search query.
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FLND Wi et il

i v| xE & | il Reply Gl Reply Al g Forward ||

Folder list Inbox

All folders || mearch I Sukject or Sender 'I for |startrek Search | Clear |

= EF 1nbox - . t 8| # [From |Susject |Received ¥ |Size | %
@ Calendar I& STARTREK.COM THG &t 20, Star Trek convertion neves, Dochan memorisl and mon Tue 0500107 20:04:17 95kk K =]
@ Cortacts @ STARTREK .COM Movie neves, new column and iTunes all on STARTREK .COM Tue 0372707 17:17:05 47kh W
@ Delsted tems £y STARTREK.COM STAR TREK ¥l The Latest Mews Fri 0302407 170516 48kh ¥

@ ; Drs @ STARTREK .COM Star Trek Recommends: Save 10% on Everything in the Store Tue 02720007 16:31:22 S4kh W

) STARTREK.COM Star Trek on iTunes, Remastersd news and more! Tue 020607 16:16:31 GOkb '
Journal () STARTREK.COM Star Trek Recommends: Save 10% Tue 01023007 2212:20 9kb ¥
8 Jurk E-mail
Motes
3 Outhax
L ;,;' Sent kems
@ Tazks

2.22. Search Result

When finished searching press the Clear button (red circle icon) to return to the normal
list view. To remove the search bar click the Search button in the tool bar again.

Archiving functionality is provided by the Zarafa Archiver, a product that is be
offered separately from ZCP.

2.4.5. Downloading Attachments

Attachments can be downloaded one by one, by right-clicking the attachment and selecting
Save target as. From ZCP 6.50 up, it s possible to download all attachments from a
message at once, in a compressed ZIP file, by clicking the Download all Attachments
button, as seen in 2.23 “Message Attachments”

Attachments:

ey Download all attachments wallpaper-69393 jpg (1331kb): wallpaper-T4836 prng (1958kh); wallpaper-288717 jpg (125kb);

2.23. Message Attachments

2.4.6. Attach items to mail

To add items as attachments or forward them as text message in body of composing mail.

1. Click on Attach Items button or envelope with paper clip icon (see: Eﬂ 2.24 “Attach
Ttem Dialog” ).
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2.

Create E-Mail

_jzend |[B) & & AEII@:IE.:I b B2 | options ¥ |

From: Attach ltems N

To.

}

Look in:
Ea
Ep T pr—— S T
Attachments: ‘@ Contacts

@ Deleted tems Insert As

iB 7 U ke x & Drafts L O Text Only

3 B i @) attachment

: Format | Marmal o

Journal
tank 8 Junk E-mail
anLS, @ Motes b
Shyam
Select from: |4 4 Page 9 of 10 p Pl
. | | # |Suhject |Received |Size | W

I # Task Request: dddddd Fri 09-07-2010 19:23 Gkb | v
i test Tue 22-06-201019:04 kb | %
i testing it should move to cas Tue 23-03-2010 1551 kb | %
= # Tue 23-03-201011:25 230k | %
& . Tue 23-03-201011:18 230k | %
L Pt to ever 1 Ved 14-07-2010 1839 2Kk | %
[ P to ever 1 Fri 16-04-2010 11:47 3Kk | %
[ to ever 1 Fri 16-04-2010 11:44 kb | %
[ tr Mon 03-05-2010 19:10 kb | %
8 # Undelivered Mail Returned to Sencer Tue 13-07-2010 1506 10kk | T

2.24. Attach Item Dialog

It’ s possible to quickly forward e-mail messages as attachments. Right-click the
Forward Items column in the message list.

Browse through the message 1ist and select the items need which to be attached.
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Calendar usage

Create E-Mail

Frarm: | - |
[ To... ] |test'5 =testBi@zarafa local=; |
C e |
e | |
Subject: sample for Attach tems |
itern attached as Attachment |
B I Ud|x x|iEE|EElg c BIE=E==)Eq
i Fomnat | Normal |~ Font | |~ | Size | |v|] M- ajpvlé 8 E2 ] E]
[l
[
item attachment as Text in body
]

2.25. New Mail with message items added as attachment

Items can be attached as Text or as Attachment, By selecting the check box as
required, by default, items are added as Attachments.

Items can be quickly attached by doing a double click on selected items.

W i

Attachments in the original e-mail are not forwarded with the new text message.

2.5. Calendar usage

2.5.1. Create new appointment with invitations and free/busy

status
1. Select the folder Calendar.
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2. Select the button New to create a new appointment. A dialog as shown in 2.26  “New
Appointment” pops up.

Appointment

{Invite Attendes:

IRecurrenc

Appointment _
Subject: | zalez meeting
Location: | Delfy |Label: I kone W
Start time: | 05-10-2002 Iz B O sipey event
End tirme: | 05-10-2002 I =
|:| Feminder: I 15 minutes Busy Status: | Busy W

[ Attachments: ]|

[ Contacts: ] | |[ Categories: ] | Frivate ]
2.26. New Appointment

3. Insert a subject for the appointment, and optinally a location.
4. Select a start and end time for the appointment.

5. Optional: Enable the reminder option, this will trigger a reminder pop-up (see: 2.27
“Reminder dialog” ) before the appointment starts. The time interval between the

reminder and the appointment is adjustable in the field next to the reminder option.
When it is time for the reminder to pop-up, the Zarafa WebAccess shows a list of these
reminders with buttons to Open the item, Dismiss the item, Dismiss All items or to
Snooze the reminders by a given time.

Pop-ups need to be allowed by the browser to see reminder pop-ups. Often this
needs the domain name of the Zarafa WebAccess to be whitelisted for pop-ups in the
browser.
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Create new appointment with invitations and free/busy status

0 reminders are selected
'@ work meeting 17 minutes overdue >,
Dismiss All Openltem || Dismiss |

Click Snooze to be reminded again in:

5 minutes - | Snooze |

2.27. Reminder dialog

6. Using the button Invite Attendees one can send a meeting request as shown in 2.28
“Meeting request” . To add attendees, simply add their email addresses. The email
addresses need to be separated by a semicolon. By clicking the To: button contacts can
be selected from the Address Book. The attendee will receive a meeting request which
the attendee can Accept, accept as Tentative or Decline, alternatively the attendee can

also Propose New Time for that request.
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isend aSave| :‘,.-| & | f:JHecurrence | (A cancel Invitstion || L | ||

Appointment

Lucaz Test <Lucas@unit] . zhestnl:;

Sybject: zales mesting

Location: Drelft Label: Mone w
Start time: 06-10-2008 7ol 1430 = [ i Day Evert

End time: 06-10-2008 ~i 1m0 | =

|:| Retminder: I 15 minutes Busy Status: I Busy W

Attachrents:

private ]

2.28. Meeting request

7. By opening the tab Scheduling, the free/busy times for multiple people are shown (see:
2.29 “Scheduling/FreeBusy” ). On this tab colleagues can be invited (Add a name);
an overview is showing exactly when a specific person is busy, out of the office, or
available. If an attendee has proposed a new date or time for a meeting, the proposals

are shown on the Scheduling tab as well.

_isend Bsave | & | & | (ORecurrence | [Acancelinvitation | ¢ & ||

Scheduling ]

| Proposed start date and time | Proposed end date and time |Duratinn | Proposed by
11-08-2008 15:00 11-09-2008 15:30 30 minutes =Current Meeting Time= -
5 11-08-2 01

T hours Hilde Test

Thu 11 Sep 2008
M 07 DB 09 10 11 12 13 14

| »

Zoom 1day =
1 00 01 02 03 D4 05

All Attendees

Inge Test
[ | Hilde Test
[E¥ = | Hilde Test

m

1

] [ ] ] b

Aumpick Start time: 11-03-2008 [Ta] 15:0 j
_— e - =
End time: 11-08-2008 =] 2201 =

| Busy % Tentative Bl Out of office No Information

2.29. Scheduling/FreeBusy

22



Accept a meeting invitation

All Attendees

9 =X

+ Required Attendee
2 Optional Attendee
{3 Reszource (Room or Equipment)

e | AutoPick == Start time:

2.30. Meeting request
8. Colleagues can be added via the Add a name field.

9. Attendees can be marked either as “required” or as “optional” . It is also possible
to schedule a resource — like a room or a piece of equipment — needed for that meeting.

Resources have to be created by the administrator.

10. In the Tracking tab a list with all attendees for this appointment, with their
responses, can be found.

Meeting

: | B ! | Tracking ]
The folewing responses to this meeting have been received:
james Organizer No Response s
Luis Test Required Tentative

2.31. Tracking tab

2.5.2. Accept a meeting invitation

If someone invites you for a meeting, you will receive meeting invitation. At the top
of the invitation a bar containing the buttons Accept, Tentative, Decline and Propose
New Time is shown for sending a response to the owner of the appointment. See 2.32

“Meeting invitation buttons”

i) Accept &) Tentative (J) Decline =] Propose New Time

2.32. Meeting invitation buttons

By clicking Propose New Time a user can propose a new date or time to the owner. The

owner, upon receiving the proposal, can either accept it or decline it.
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2.6. Multiple calendar views

The Zarafa WebAccess calendar has five different views:
+ Day view

+ Workweek view

+ Week view

-7 day view (like the workweek view, but with 7 days)
+ Month view

Views can be switched via the four buttons in the tool bar.

The date picker is used to move the view to another day/week/month, which is at the top

right of the screen when the calendar is opened.

2.6.1. Move/delete appointment

2.6.1.1. Move appointment

An appointment can be moved to another time/date by selecting the item and dragging it to
the new date and time. Alternatively, (for instance if the new date is not in the current
view) an appointment can be opened (either by double clicking on it or by right clicking
on it and choosing the Open option), which presents a dialog where the new date and time
can be set.

2.6.1.2. Delete appointment

Appointments are deleted by the delete button in the context menu that shows when clicking
on an appointment with the right mouse button. Alternatively, one can use the Delete
button in the tool bar, or the Del/Delete key on the keyboard.

2.7. Multi User Calendar

Opening other users calendars side-by-side is possible with the Multi User Calendar (see
2.33 “Multi User Calendar” ): click on the Open Multi User Calendar link in the bottom
of the folder pane.

This feature is not available in the community version of Zarafa.
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Adding a user to the time line

2 m————————— s ——————————— . i

Chew +| ¥ . & | 44 Previous Period 4 PreviousDay b NextDay M Next Period| € Load Group 9 Add User JRemove user |

Al folders

1 € Inbox - Simon Koster = o m hion 1 Gct 2007 | Tue 2 Oct 2007 [ Wed 3 Oct 2007 | Thu 4 Got 2007 [ Fri 5 Oct 2007
Agenda W2 15 & 21 5 1z 145 da 21 B2 15 48 2 S M2 45 da o 9 M2 5 18 21

@ Calondar |Al sttendees

& concepten ! 1 Marketing meeting Board meeting

: : (The Office) (The office)
© Contactpersonen I i poe H : 11:30 - 14:30 13:00 - 16:00
D contacts

P Deleted tems [Me<ting with custs Meeting customet Meeti
2 Dratis (Hotel ) (Company) (Compat
42 Inbox 09:00 - 12:00 09:00 - 10:00 10:00 - 12

Make followp call [Marketing reeting Seminar Marketing 2007
(
0

{The Office) {Hotel)
17:30 - 18:00 00:00 - 00:00

2 dournal " [sates meetin C: call : Meet with CED Call customer
2 durk E-mail i |(The office} H (The Office) (The Office)
I Jane Do [ R i

3 Loghoek 2400 - 15:00 100 - 11:00 14:30 - 1530 10:00 - 11:00

2 Motes Meet with associal Conferénce call

D nntties (Company) (The Office)

8 Ongewenste E-mail 14:00 - 15:00 1:00 - 12:00

2 utbox |
o

Conferénce C all | Markeling Meeting i
(La Place Hotef) (The Dffice) (The Office) (The Office)
130 - 06:00 17:00 - 18:00 18:00 - 19:00) 12:00 - 13:00 20:30 -[21:30 08:30 : 09:00

=[5 Postvak IN
Pteat
"3 Postvak UIT

Meeting Private s i Marketing Seminar Meeting new cust
2 Sent tems  ebion @ # (Utrecht)
D Taken 0s Blove 12:00 - 13:00, 21:00 |- 21:30 15:00 - 19:00; 00:00 - 00:00 [12:00 - 43:00
D Tasks - -
e e ” Business excursion
@ verwiderds ftems (25) e
"3 Verzonden items: 00:00 - 00:00
3 &3 inbox - Joe Blow ’
@ agenda of johnsmith I . . e [
=1 &3 public folder ™" dobn Smith (hlew) @ ' ou don' have permission to view this folder
- Favarieten L i : : ]
' Publiske Mappen =

Open shared folders
Open Muki User Calendsr

| Postuak I

| 1

you are loggedl on = Simon Koster - setiings - oo out

 tems - (0) new:

2.33. Multi User Calendar

2.7.1. Adding a user to the time 1line

1. Click on the Add User button in tool bar at the top (see: 2.34 “Timeline” ). The
Address Book window will open.

b hlext Period | 2 Load Group @ Add User )@Remove user |

Man 1 Oct 2007 Tue 2 Oct 2007

12 15 18 ™ 9 42 15 13 2 ]

2.34. Timeline
2. Click on a user to select that person and click on the button Ok.

3. The user is added to the time line and his/her appointments are loaded.

2.7.2. Deleting a user from the time line

Select the user by clicking on the check box in front of their name. Click on the button
Remove User in the tool bar at the top.

2.7.3. Loading a group of users to the time line

1. Click on the button Load Group::- in the bar at the top. The “Group Window” , as shown
i 2.35 “User groups” , will open.

25



# 2 E Using the Zarafa WebAccess

:/ flocalhost - User group - Mogzilla Firefox - |EI|5|
Users
Jane Doe o]+
John Doe —
FR
[~ [~
Ok I Cancel
| [ | Done | Q

2.35. User groups
2. Select a group in the left list and click on the button Ok.

3. The group of users is added to the time line and their appointments are loaded per

user.

2.7.4. Load group dialog

The Load Group dialog can be opened by clicking on the button Load Group in the bar at at
the top.

The dialog consists of two lists. The list to the left shows the different groups that
have been created. The list to the right displays all the users that are members of a
particular group when that group has been selected from the left list.

To add or delete a group or user use respectively the plus or minus buttons on the right
side of the list. Remember that a group must be selected prior to adding or removing a

user.

2.7.5. No Access message

When using the Multi User Calendar with several calendars of collegues open, one might not
have permission to create appointments for a colleague, or not have permission to view the
content a colleague’ s calendar at all. In case one does not have permission to create an
appointment for a colleage, an icon is placed after the colleague’ s name as an indicator.
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Cumulative free/busy information

In case one has no access to the calendar at all,
marked red and a warning message appears as shown in 2.36

3 "
No Access message

the entire time line for that user is

L

™ Joe Blow @

Cu:rnferém:e
{La Place Hote]

17:00 - 18:00
Mesting | Sal
{Amsterdamy)

"

=¥ zilfds

12:00 - 13:00°

21:00 | 21:30°

{Maastricht)
000 - G000

Business excursion

I John Smith (Hewy @)

__.._____________________ﬁ______.__

i' You dont have permizsion to view thiz folder.

& 2.36.

No Access message

2.7.6. Cumulative free/busy information

The row directly above the time lines (see: 2.37

“Free busy information for all

attendees” ) contains the cumulative free/busy information of all users loaded in the

Multi User Calendar. The bar also shows whether the appointments are set as Tentative,
Busy or Out of Office.

Previous Day ®  Mext Day b Mext Period  ¥3 Losd Group € Add User mﬁmvs user |

ser Calendar

mf5 'I

Maon 1 Oct 2007

Tue 2 Oct 2007

Wied 3 Oct 2007

9 12 15 18 2 9 M2 d5 a8 A 8 d2 15 u8 A 9
: (N N | T
e
IMeeting with custe Meeting customer Meeting Make followdp call JMark
{Hotel ) : (Company) (Company) {The Office) {The
joo:00 - 12:00: 09:00 - 10:00 10:00 - 14:00  |17:30 - 18:00 09:00
Sales meeting Conference call Meet with CEQ Cal
{The Office) {The Office) {Th
- 14:00 - 15:00 10:00 - 11:00 1430 - 15:30 102
Meet with assfoeim C
{Company) {
1400 - 15:00 | 1

B 2.37.

Free busy information for all attendees

2.7.7. Create or delete an appointment

To create an appointment simply double click on the time line of the user an appointment

has to be created for. This will open a new appointment window where the appointment can

be created.
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To delete an appointment: double click on the appointment to open it, then use the red
cross in the toolbar of the appointment dialog to delete it.

2.7.8. Moving appointments

Moving an appointment can be achieved by opening the appointment and changing the start
time. In practise most users will prefer moving appointments by using drag-and-drop. To
drag an appointment the user clicks and hold down the left mouse button on an appointment
and moves (drags) the mouse over the time line to the desired location, to release the
mouse button at that point. To help place the appointment a red overlay (see: 2.38
“Dragging appointments” ) follows the mouse to indicate new place of the appointment when
the mouse is released at that point.

0 - 15:00 10:00 - 11:00

lohn Doe 1 ; i | | ' i i i i
Meet]12:00 - 16:00 I ' Meetil1g {:uétomel.l‘ '

{Hot ; : {COI‘I*]‘HIU} : : :

0900 ! 0 0900 - 10:00 ! 0

5 meeting Conference call g

[ thce} : : i i

lane Doe ! ] :

Meet wlith associal
{Company)
14:00 - 15:00

Conferénce
iLa Place Hote])

-
e LR E LT LR
st
=]
1
=
-=-----
=
=

17:00 - 18:00 ; 18:00 - 19:00
Meeting | sadfzFzdfds i i i
{Amsl:tenlan:‘l} E E E E
loe: Blow @ 12:00 - 13:00, 21:00} 21:30 : L
E E E E Business excursion
0 0 ! 0 {Maastricht)
g : I 0 00:00 - 00:00
i f ] h ] |
lahn Smith G4 ¥ vou dont have permizsion to view this folder. g g i 5

2.38. Dragging appointments

It is also possible to drag an appointment to the store of another user (provided enough
permissions are granted). Simply move the mouse to another user’ s row and the red overlay
will follow.

2.7.9. Changing zoom level

It is possible to quickly zoom in on the time line by changing the zoom level using the
drop down menu (see: 2.39 “Zoomlevel” ) in the top left corner of the Multi User
Calendar. This setting is not saved and will be reset to the default setting (as set in

the settings dialog) next time the Multi User Calendar is opened.
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Changing number of displayed days

I Multi User Calendar

L )
I 5 v L

naml I 5 T

Al attendees | -

r John Doe

2.39. Zoomlevel

2.7.10. Changing number of displayed days

The number of days that are loaded in the time line and the number of days that are

visible at the same time (zoom level) can be set from the settings dialog: on the Calendar

tab in the Multi User Calendar View section. These settings will be used whenever the

Multi User Calendar is opened.

2.7.11. Browse time period

The Previous Period and Next Period buttons on the tool bar at the top of the page (see:

2.40 “Buttons for changing time period” ) are used to view the next of the previous
time line period. The Previous Day and Next Day buttons merely move the time line by a

single day.

s

i | 44 Previous Period 4 Previous Day B Mext Day ke Mext F‘eriod| r

| | Multi User Calendar

2.40. Buttons for changing time period

2.8. Tasks

In the task folder a to—do list can be created and managed. A task is created with the

following steps:

1. Select the folder Tasks

2. Use the button New to create a new task. A New Task dialog will be opened as shown in

2.41 “New task window” .
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T P T e e T T T T T T T TP TR PR PER PP TCET TRt L L 0 L R 0 L B 0 L L 0 R 0 L R A0 L B St S 1)

Taszk
Subject:
Due Drate: Mane E Status: Mot Started [VJ
Start Date: Hone 3 Priority: Mormal [V] % Complete: 0% ﬂ
|:| Reminder: E ill Crner: anancd

Attachments:

Private ]

2.41. New task window

3. Fill in the preferred fields. The fields in this window are comparable with those in
the New Appointment dialog.

4. Use the Save button to confirm. The task can now be found in the task overview.

Alternatively, new tasks can be created directly from the Tasks overview (see: 2.42
“Task overview” ). Right below the tool bar the fields for creating a new task as shown.
Simply enter the field for a new task directly into these empty field and save it with the

ENTER key.

|B|6A] ¢ Subject | Due Date |Dwiner
- 'I Hilde Test a8
Wy [] - Getacupcoffee Hilde Test -
~ report Klaas about the new schedule Hilde Test
20O

2.42. Task overview
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Recurrence in Tasks

2.8.1. Recurrence in Tasks

Task Recurrence

—Recurrence pattern

O Daily %) Every 1 [yweekl=) on
E} Vyieekly D fonday D Tuesday DWednesda'f Thursda'f
' Monithly
D Friday D Saturday D Sunday
O Early R
O Fegenerate new task 51 week(s) after each task iz completed
- Range of recurrence
Start: 28-01-2010 5] o end dats
) End after: 10 OCCUPTENCEs
(End Bry: 28-01-2010 =
QK ] [ Cancel ] Femowve Fecuirence

2.43. Task Recurrence

2.8.1.1. Add/Change Recurrence in a Task

Only the owner of a task can change the task in a recurring task.

1. Select Recurrence from menu in task dialog shown in 2.41 “New task window” . This

pops-up a recurrence dialog as shown in 2.43 “Task Recurrence” .
2. Select the frequency (Daily, Weekly, Monthly, Yearly) of recurrence.
3. To specify when the task repeats, do one of the following:

- Repeat the task at regular intervals: Click on options given on the right-side of

Recurrence pattern to recur the task on specific intervals

- Repeat task at interval after the date it is completed: Click Regenerate new task and
fill the interval in the box.

Recurring tasks appear one at a time in the task 1list. When user marks one occurrence

of the task complete, the next occurrence appears in the list.

2.8.1.2. Remove Recurrence from a Task

1. Open the recurring task
2. Click Recurrence from menu in task dialog.

3. Click Remove Recurrence as shown in 2.43 “Task Recurrence”
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2.8.2. Task Requests

In addition to creating tasks for oneself, a user can assign tasks to others by sending
them a task requests.

Subject: | |

Cue Date: |Nn:|r'|e |E Status: | Mot Started |-£||
Start Date: |N|:une | E| Pricrity: % Complete: g

Keep copy of task in task list.
Zend me a status report when task iz completed.

| Attachments: ]|

| Contacts: | | |[ Categories: | | |F'rivate ]

2.44. Task Request

2.8.2.1. Assign a task to someone

1. Click Assign Task from menu in task dialog as shown in 2.41 “New task window” .
This will show Task request fields as shown in 2.44 “Task Request” .

2. Enter user address in the TO field. The user s address can also be resolved either by
clicking Check Names button in menu or from Suggestion List which pops-up while typing
user’ s name.

3. Select or clear the Keep an updated copy of this task on my task list check box and the
Send me a status report when this task is complete check box.

4. Type instructions or information about the task in the body.

5. C(Click Send

If a recurring task is assigned, a copy of task is created in task list but it won’
t be updated. If Send me a status report when this task is complete check box is
selected, a status report will be received for each completed occurrence of the task.

2.8.2.2. Accept or decline a task request
1. Open the task or task request.
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2. Click Accept or Decline.

2.8.2.3. Reclaim ownership of a declined task
1. Open the task that contains the decline task request

2. Click Return to Task List

2.9. Contacts

The Contacts folder has multiple views: card view and list view. Switching between views
is done with the buttons on the tool bar.

Emails can be send directly to contacts by the right mouse button context menu option

Email Message.

The letters at right side of the contact view allow users to quicky move through the

contact list.

Dliew -| X 5 & | cards Lt

Folder list Contacts

All folders e

= &3} inbox - Alex Test Charly Peterson
2 Calendar Wiork; e
@ Ernail: e -
3 Deleted tems (5) IBM (Dear, John)
& Dratts Work: e

E Lj inbox (2) Ernail: e

-‘-.'-_:_‘Ei lmrnal

2.45. Contacts

2.9.1. Create new contact

A new contact is created with the New button in the tool bar, when the viewing the
Contacts folder.

The New Contact dialog is then shown allowing a user to fill in all the information about

a contact before it is saved with the Save button.

With the option Private, in lower right corner of the New Contact dialog, the contact can
be hidden from colleagues that have access to that Contacts folder.

2.9.2. Detailed Contacts

Since ZCP version 6.30 the WebAccess provides a detailed dialog for contacts as shown in
2.46 “Details of a contact” .
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Bseve| 2|
Genearal
—Matme —Email
Full Marne... h——— | Email ]
Function: | Display Mame: |
Comparny: Wiebpage:
File &s: | T Iv] I - Aclclress:

—Fhare numbers

s
(e [2) [=

e anl[) |

(isbin. ][] |-

— Additional Infarmation

—Addresses
[Business. ][] o
[ Uze this

address for mailing.

— Attachments

Attachments:

2.46. Details of a contact

| | Private []

In the Contact window, buttons are available instead of labels; click a button to show the

details for that particular field.
(K] 2.47 “Name details dialog” ),

Screenshots of the detailed dialog boxes for Full Name
Phone Number ([&] 2.48 “Phone details dialog” ) and

Address (& 2.49 “Address details dialog” ) are shown below.

Name details

Title:

First:

KMiddle:

Last:

Suffic

@ Show this again when name is incomplete or

Klaas

Jansen

St~

unclear

ok | [ Cancet ]

2.47. Name details dialog
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Detailed Contacts

Phone details

Country/Region Code: +31-

CityfArea code: 015

Local number: 123456

Extension:

ok J[ Cancel |

2.48. Phone details dialog

Address details

Hooftstraat 63

Street:

City: Delft
State/Province: Zuid-Holland

ZIPiPostal code:  2524HT

Country/Region: Metherlands

[¥] show this again when address is incomplete or
unclear

ok J[ Canced |

2.49. Address details dialog

There are three types of address fields (Home, Business and Other). The drop down menu
shown in E}{ 2.50 “Cascade menu to choose the address type’ 1is used to change between

these addresses. In this menu, ticks are shown besides the address types indicating which

addresses have been entered already.

- Addresses
Home: Home
D i et aidees +'| Business
o e | Dther

2.50. Cascade menu to choose the address type

Different types of Phone Number fields are available in the Zarafa WebAccess. To change

the Phone Number type use menu shown in 2.51 “Cascade menu to choose the phone type”

In this menu, ticks are shown besides the address types indicating which phone number

types have been entered already.
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Blsawe | & | 15| x|

General - Assistant

—MName ——— Business —
Full Name: Business 2
Function:
Business Fax
Company:
File as: Callback =
Car
— Phone numbers — —

Business: E] Ce
Business Fax: E] Home 2

— Addresses——|  1SDN -
Business: E] Maobile h
Other
[ Use this address
for maiing. Other Fax
Pager
— Attachments —] ag —
Attachments: Primary
Radio
Telex
[ Contacts: TTY/TDD

2.51. Cascade menu to choose the phone type

2.10. Distribution Lists

Sending a mail to a distribution list is done in the same way as sending a mail to a
single contact. Simply select the distribution list from the address list when adding
entries to a TO, CC or BCC field. After selecting the distribution list, all mailaddresses
will be placed in the chosen header field.

2.10.1. Creating new distribution 1lists

Select the Contacts folder the new distribution list has to be created in. Select the
option Distribution List from the New button on the tool bar. A dialog as shown in 2.52

“New Distribution list window” will open.
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Public Folder Favourites

Distribution List
BSave |

Hame: |Sales colleagues

[ESemcﬂﬂembemmén Ao new. H Remove...

| |Name|E-maiI
2 Lucas@unit] ztest.nl
G Luke@unit! ztestnl

private. []

2.52. New Distribution list window

With the button Select Members contacts can be selected from the Address Book to add
to the distribution list. Alternatively, the Add new button can be used to create a new
contact that is added to the distribution list immediately.

New e-mail address

Hame || |

Email Address | |

[ Ok ] [ Cancel l

2.53. Add new address dialog

With the button Remove selected contacts are removed from the distribution list. Contacts
are selected by single clicks in the lower part of the dialog.

Notes can also be added to the distribution list from the Notes tab.

2.11. Public Folder Favourites

The Favourite folder, located under the Public Folders, is a place where shortcuts to
often used public folders can be stored. To add a public folder to the favourites, right
click on that public folder and select Add to favourite folder. A dialog as shown in

2.54 “Add to favorite folder window” will appear. It asks: “Fill in a name for the
favourite folder (by default the same name will be given to the folder)” . By default only
the selected folder will be inserted in the favourite folder without subfolders (unless
specified otherwise) .
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) Add to favorite folder - Mozilla... [= |[B)[X]

I |j http: ffunit1. ztest.nl fwebaccessfindex. php?load: "T?

Add to favorite folder

Public folder name: | |

Fawvorite folder name: |To Do |

Add zubfolders of this folder
() Add immediate zubfolders only

{51 Add all zubfolders

[ Add ] [ Cancel ]

Dione 0 /548

2.54. Add to favorite folder window

2.12. Rules

Rules automatically perform actions on incoming messages based on certain criteria, they
can move, copy, delete or forward the message. When a message is deliverd the rules are
applied directly on the Zarafa Server, so a user does not have to be logged in to execute

the rules.

To create or edit rules, first open the Rules dialog by clicking on the Rules button in
the tool bar (see: 2.55 “Rules button” ). This button only shows when a mail folder is

opened.

& Zarafa vicoaccors i —————

| cdReply cdReply 81 gdForward | #Search | *IRules | L Restare ftems |

........................

e

Folder list

Al folders |Fraim Received ¥

= &3 Inbox - Luis Test
2.55. Rules button

A dialog as shown in 2.56 “Rules overview dialog” 1is presented. In this dialog a
user s rules can be created, modified or deleted. It is also possible to change the order
in which the rules are applied. To change the order of a rule select it and click the Up

or Down button.

To disable a rule without deleting it, click the checkbox in front of that rule. Only
checked rules will be executed upon the arrival of new mail. After checking or unchecking

rules, click the Ok button to save the changes to the server.
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Rules

The following rules have been defined:

| |Name |
v mail for desvelopmert :I
gez from Michael MHew...
¥ newvsletter from zarafa Edi...
v delete all mail from Simaon Delete
v private mail | i
Do

Ok Cancel I

2.56. Rules overview dialog

To create a new rule, click the New button in the Rules dialog. The dialog as shown in
2.57 “Add/edit rules dialog” 1is presented. This is the same dialog as the dialog for
editing rules which is opened by selecting a rule from the Rules dialog and clicking the
Edit button.
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AddiEdit rule

-Rule

Rule natme |Messagesfrn:um bichael

~With the following properties

From field cortains . e : ﬁﬁ:l
=ubject contains

Priority I ll
-Sent to

Contact ar distributionlist I @l

=ent only to me |_

- Perform the following action

(s hoye to Developing
. Copy to falder
f" Delete the message

. Forward to I @I

| Ok 1 Cancel

2.57. Add/edit rules dialog

In the Rule name field a short description of the rule — to identify it in the rules
overview dialog — can be provided. Below the Rule name field the criteria of the rule

are specified. The incoming message can be matched by sender address, by subject, by the
priority it has, by the recipient address, or based on if the message has “only been sent
to me” . These criteria can be combined to match messages more specifically. The buttons
behind the input fields to open the Address Book to select an email address.

W oz

A1l the criteria filled in must be fulfilled in order for an email to be seen as

matching the rule.

While it is possible to combine the *Sent to™ Contact or distributionlist and the Sent
only to me criteria, they can potentially contradict each other thereby rendering the

rule useless.
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Settings

Finally the action must be picked. This speaks for itself. When setting the move or copy
action, the destination folder must be specified by clicking on the underlined text.

When finished close the dialog by clicking the Ok button. To save the rule, the Rules
overview dialog must also be closed by clicking Ok.

2.13. Settings

In the bottom-right corner of the Zarafa WebAccess, to the left of the log out 1link,
resides a settings link by which the Settings dialog can be opened. The Settings dialog
contains 6 tabs, the follwing sections cover each of the tabs.

2.13.1. The “Preferences’ tab

E Save @ Cloze |

~General
Language I English j
Color theme I default j
Mesy mail check timeout I 5 minutes j
Automatic logout | After B0 minutes j

-Folder Options
Startup folder

| Last opened falder
Mumbet of tems to display per page I 100

-

L] e

3 Reading pane visible

2.58. Settings: Preferences

- Language, sets the default language for the WebAccess.
- Color theme, pick one of silver, white and the default (blue).

+ Automatic logout, use this option to increase security and set the WebAccess to logout
automatically if it goes unused for the specified amount of time.

+ Startup folder, the folder that is displayed when logging in to the WebAccess.
+ Number of items displayed per page.

+ Reading pane visible, if and where the preview pane for emails should be located. Pick
one of Right, Bottom or Off.

* New mail check timeout, by default the WebAccess will check every 5 minutes for new
email.
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+ How to respond to requests for read receipts, pick on the the options.

+ Edit Delegates---, opens a dialog for choosing which users are allowed to be the current
user’ s delegates. Delegates are allowed open the current user s store, and send
messages ——emails or (responses on) meeting requests—— on his behalf.

- Results refresh every (X) seconds, how often (if at all) the results of advanced
searches should be refreshed.

2.13.2. The “Compose mail” tab

Elsave @Close |

- l:':'mF":'SE mail _-_

-General

Reply-to address | |

Compoze mail in this format HThAL A |

|:| Close original message on reply or forvward

D Alvways request a read receipt

D AutoSave unsent every: minutes

Cursor position when replying Start of dey w |

~From Email Addresses

Set FROM email addreszes +

- Signature

D Alvways add signature to autgaing mail

[ Edit signatures...

2.59. Settings: Compose mail

- Reply-to address, the address that recipient of a users emails will “reply to” when
replying.

- Compose mail in this format, composing new mails as Plain text or HIML (rich
formatting) .

+ Close original message on reply or forward, when double clicking a mail in the list view
a dialog pops up showing the message. With this option enabled that dialog will close
when either its reply or its forward is clicked.

+ Always request a read receipt, turn this on to automatically request read receipts.

+ AutoSave unsent every: --- minutes, set when to auto-save unsent messages.
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The “Out of Office”

tab

+ Cursor position when replying, where to start entering text when replying a mail.

+ Set FROM email addresses, here the addresses that can be used to send mail FROM are
specified. Use the ‘+’

select it and click the

button on the right to add an address; to remove an address

selected from a drop down menu on top of the TO field — this drop down menu contains
addresses picked with this setting.

Name |user name |

Email Address |user@zarafa.com |

. Cancel |

2.60. Example: Set from address

- Edit signatures---

replies and forwards——- are managed. See 2.61 “HIML signature”

button. While composing an email the FROM address can be

the

, opens the signature dialog from where signatures -—-for new mails or

Signature for new messages: -%ES%“ -
Signature for replies and forwards: =-7-I'-*~]-|:Jr1e:=‘ i
Remove ] | MNew ] [ Save ] [ Rename... ]
(B LU x i EEELY BelEz===l=a)
¢ Fomat |Nomal = | Font [+] 5ize | -j Y- algy,ié =2 ] ._ﬂi
BusmessDevﬂopment
Ol.l"l:lttok shiring d!:Qbﬁ.Q |
Ok | [ Cancel |

& 2.61. HIML signature

2.13.3. The “Out of Office” tab

Here a user can mark himself “in” or “out” of the office. The AutoReply message that
is sent automatically in reply to all incoming messages can be specified on this tab as

well.
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To prevent flooding, AutoReplies are only sent once per day to a specific email address.

2.13.4. The “Calendar’ tab

- Start and End of workday, specifies the part of the day that is marked as ‘“‘workday” .

- Vertical size, the vertical size of the calendar. People with very large displays want

to consider setting it to Large.
- Calendar resolution, the smallest time block that appointments allign with.

+ Default Reminder, wheather or not reminders are added to appointments by default, and
if so, how long before the appointment start the default reminder should occur. These

setting can be overwritten per appointment.
The following options relate to the Multi User Calendar (MUC):

- Number of days displayed, the number of days that are visible at default zoom level in
the MUC.

- Number of days loaded, the number of days that are loaded. When this number is larger

then the Number of days displayed, the remaining days need scrolling to be visible.

2.13.5. The “Addressbook” tab

- Default selected folder/addressbook, sets which folder of addressbook should be used by
default throughout the Zarafa WebAccess.

2.13.6. The “Shortcuts’ tab

Here keyboard shortcuts can be switched “on or of f

’”

. All the available keyboard
shortcuts are listed here as well.

2.14. Firefox Extensions

Since the Zarafa WebAccess is web application, it cannot deliver all functionality
a native application can. Especially integration with the desktop is hard for web
applications. To overcome this Zarafa has released two extensions for Mozilla Firefox%

since most of our clients use this fully open source browser.

Currently Zarafa offers two Firefox extensions from its website:

2.14.1. Zarafa Attachment Drag ‘n’ Drop Extension

By installing this plug-in it is possible to use drag-and-drop for files in order to
attach them to messages. It is possible to drag and drop a single file or a selection of
multiple files.

From 6.40.4 up, this plug-in also allows messages to be dragged and dropped to the
desktop. This function is used by selecting one or more messages and then dragging and
dropping the envelope-icon to your desktop, as seen in 2.62 “Drag messages to desktop

. ”
1Ccon .

! http://mozilla.org

44


http://mozilla.org
http://mozilla.org

Zarafa New Mail Notification Extension

From 6.40.5 up, the add-on is no longer included in the ZCP packages, and can only be
installed from the Mozilla FireFox add-ons site located at https://addons.mozilla.org/
en-US/firefox/addon/zarafa-dragndrop/

|Fr|:|m |Recei\-'ed ¥

Man 16-08-2010 14:45

Acleem Test Mon 03-03-2010 1506
?
é} RE: test
Cody kolenboer Mon 09-08-2010 15:05
A =4

2.62. Drag messages to desktop icon

2.14.2. Zarafa New Mail Notification Extension

The Zarafa New Mail Notification Extension allows users to check their Zarafa Inbox

without opening the Zarafa WebAccess or Outlook. A Zarafa icon is put in the bottom right

corner of the Firefox browser and will inform the users about incoming mail. A double

click on the icon will redirect users directly to their WebAccess.

2.14.2.1. Settings

With a right-click on the Zarafa icon the extension’ s settings are accessible, as shown

in B 2.63 “Zarafa Mail-checker extension settings” .
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1

o & &

o)

Main Tabs Content  Applications F'riv.an:y Security  Advanced  Ea

Basic settings

Active
LRL

Username

Advanced Settings

[ ] Automatidy logon to the WebAccess
Open WebAccess in |.ﬁ. new Tah [

Chedck interval | S minutes W

Display alertbox when receiving new mail

Cookie ZARAFA_FIREFCX_EXT

OK I | Cancel

2.63. Zarafa Mail-checker extension settings

It is possible to activate or deactivate the plug-in.
It is necessary to fill in the url of the Zarafa WebAccess and the user’ s username.

The advanced settings allow the user to personalise the plug—-in by changing the time
interval for mail check and enabling/disabling the notification for new mail. It is also
possible to specify how the Zarafa WebAccess should be opened when double clicking on the
Zarafa icon, and to enable or disable automatic login to the WebAccess.

2.15. Advanced Zarafa WebAccess configurations

2.15.1. Zarafa WebAccess as default mail client
Since ZCP version 6.20 it is possible to set the Zarafa WebAccess as the default email
client. Below we show three examples on associating the WebAccess with the default action

for when a user clicks on an email addresses link.
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Windows

2.15.2.

For all users on a computer:

Windows

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
@="Zarafa Web Client"

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
@="%windir%\\zarafa.ico"

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
"URL Protocol"=""

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mai1\Zarafa
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
[HKEY LOCAL MACHINE\SOFTWARE\Clients\Mail\Zarafa

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
@="rund1132.exe url.dl11,FileProtocolHandler http

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
@="Zarafa Web Client"

[HKEY LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa
@="rund1132.exe url.dl1l,FileProtocolHandler http

[HKEY_LOCAL_MACHINE\Software\Classes\mailto]
"EditFlags"=hex:02,00,00,00

"URL Protocol"=""

@="URL:MailTo Protocol"

Web Client]

Web Client\DefaultlIcon]

Web Client\Protocols]

Web Client\Protocols\mailto]

Web Client\Protocols\mailto\DefaultlIcon]

Web Client\Protocols\mailto\shell]
Web Client\Protocols\mailto\shell\open]

Web Client\Protocols\mailto\shell\open\command]
://<ZARAFA_WEBACCESS_ADDRESS>/index.php?action=mailto&to=%1"

Web Client\shell]

Web Client\shell\open]

Web Client\shell\open\command]
://<ZARAFA_WEBACCESS_ADDRESS>/index.php?action=mailto&to=%1"

[HKEY_LOCAL_MACHINE\Sof tware\Classes\mailto\DefaultIcon]

@="%windir%\\zarafa.ico"

[HKEY LOCAL_MACHINE\Software\Classes\mailto\shell]

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell\open]

[HKEY_LOCAL_MACHINE\Software\C1asses\mailto\shell\open\command]

@="rund1132.exe url.dl1l,FileProtocolHandler http

For current user only:

Windows Registry Editor Version 5.00

[HKEY CURRENT USER\SOFTWARE\Clients\Mail\Zarafa
@="Zarafa Web Client"

[HKEY CURRENT USER\SOFTWARE\Clients\Mail\Zarafa

o

%windir%\\zarafa.ico"
[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa

[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa
"URL Protocol”=""

[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa

://<ZARAFA_WEBACCESS_ADDRESS>/index.php?action=mailto&to=%1"

Web Client]

Web Client\DefaultlIcon]

Web Client\Protocols]

Web Client\Protocols\mailto]

Web Client\Protocols\mailto\DefaultIcon]
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e="%windir%\\zarafa.ico"
[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell]
[HKEY CURRENT USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open |

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto\shell\open\command]
@="rund1132.exe url.dll,FileProtocolHandler http://<ZARAFA WEBACCESS ADDRESS>/index.php?action=mailto&to=%1"

[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell]

[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open]
@="Zarafa Web Client"

[HKEY_CURRENT USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open\command]
@="rund1132.exe url.dl1,FileProtocolHandler http://<ZARAFA WEBACCESS ADDRESS>/index.php?action=mailto&to=%1"

[HKEY_CURRENT USER\Software\Classes\mailto]
"EditFlags"=hex:02,00,00,00

"URL Protocol"=""

@="URL:MailTo Protocol"

[HKEY CURRENT USER\Software\Classes\mailto\Defaultlcon]
@="%windir%\\zarafa.ico"

[HKEY CURRENT USER\Software\Classes\mailto\shell]
[HKEY_CURRENT_USER\Software\Classes\mailto\shell\open]

[HKEY_CURRENT USER\Software\Classes\mailto\shell\open\command]
@="rund1132.exe url.dl1,FileProtocolHandler http://<ZARAFA WEBACCESS ADDRESS>/index.php?action=mailto&to=%1"

2.15.2.1. Installing the “.reg” file
1. Open a text editor like Notepad.

2. Insert the desired registry key, where <ZARAFA WEBACCESS ADDRESS> should be replaced by
the url of your Zarafa WebAccess.

3. In the Start Menu, hit Run, enter regedit, and hit Ok.
4. Import the just created registry key.

5. In Outlook 2003/2007 go to Tools > Options > Other > uncheck Make Outlook the default
program for Email, Contacts & Calendar.

6. In the Start Menu, hit Run, enter %windir%, and hit Ok. The default Windows folder will
be opened.

7. Copy and paste zarafa.ico into the folder. The icon can be found on the server in the

following folder: /webaccess/client/layout/img/favicon.ico.

2.15.3. Linux

1. Make a new script file mailto.sh.

2. Put the following lines in the file:

#!/bin/bash

ADDRESS=‘echo $1|cut -f 2 -d : -
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Adding Zarafa WebAccess as mailto handler in Firefox

# Logs this to syslog... just helps to make sure it is working properly
logger "Opening Zarafa mail client, addressed to $ADDRESS"

firefox "http://<SERVER>/<USER>/webaccess/index.php?action=mailto&to=$ADDRESS"

3. Replace http://<SERVER>/<USER>/webaccess/ with base URL of the WebAccess.

4. Save the file (preferably in the home directory), then run chmod uog+rwx mailto.sh from
the same directory.

5. Now type gnome-default-applications—properties on a console or go to System >
Preferences > More Preferences > Preferred Applications.

6. Open “Mail reader” and set it to a custom action that looks like: /home/<USERNAME>/
mailto.sh %s

2.15.4. Adding Zarafa WebAccess as mailto handler in Firefox

When clicking an URL of an email address (a mailto address) in Firefox it will try to open
a mail client. Firefox has a list of possible mail clients to use, with the possibility to
pick a default. To use the Zarafa WebAccess to handle mailto URLs in Firefox follow the

these steps:
1. Type about:config in the address bar and press Enter. Ignore the warranty warning.
2. Put gecko.handlerservice in the filter box.

3. Double-click gecko.handlerService.allowRegisterFromDifferentHost. This will change its
value from false to true.

4. Paste this code in the address bar while replacing https://<ZARAFA_WEBACCESS_ADDRESS>
with the URL used to access the installation of the Zarafa WebAccess (usually the url
used to get to the login screen of the WebAccess), then press Enter:

Jjavascript:window.navigator.registerProtocolHandler ("mailto", "https://<ZARAFA WEBACCESS ADDRESS>?
action=mailto&url=%s","Zarafa WebAccess")

5. Below the address bar a message asking if the Zarafa WebAccess should be added as an

application to handle mailto links. Click the Add Application button.

6. Next time mailto: link is clicked, a screen will appear allowing the preferred mail
client to be picked. Select the Zarafa WebAccess, and possibly check the box next to
Remember my choice for mailto: links, then click OK.

From now on the Zarafa WebAccess will directly be used when clicking “mailto” 1links in
Firefox. Please note that a user needs to be logged in (or make use of Single Sign On) for
it to work smoothly.

2.16. Quirks

2.16.1. Firefox specific

Since Firefox 4.0, some alert messages may popup from the main window instead of in the
message dialog. Although the alert message can handled in the other window, it may be
confusing why the browser isn’ t responding. To revert the alert message behaviour to
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separate windows, the Firefox configuration needs to be altered. To do this, open a new
tab or window in Firefox and type about:config in the url bar. Filter on prompts to find
the correct option. Change the value of prompts.tab model enabled from true to false.

Alert popups will now be separate windows again.
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3

Separate WebApp manual

Zarafa WebApp has moved to its own WebApp User Manual® and is no longer part of the
general User Manual.

! http://doc.zarafa.com/trunk/User_Manual WebApp/en-US/html-single/
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Configure Outlook (using the Zarafa
Windows Client)

4.1. Installation of the Outlook client

There are two requirements that must be fulfilled prior to installing a Zarafa workspace.
First, Outlook 2003 or higher is needed, and second, the user must be created on the
Zarafa Server.

The following steps are necessary to install a Zarafa workspace:

It is recommended to have the latest Service Packs and Security patches installed.

4.1.1. Install the client

To install the Zarafa Windows Client first assure Outlook is set as default email
application from: Control panel > Internet > Applications. Then put the Zarafa CD in the
drive, wait for the automatic start of the CD and choose the uppermost option: Windows
Client. Alternatively, if the client was downloaded from another source, double click the

file named: zarafaclient.msi

With version 5.10, Zarafa is introducing an MSI installer for the Zarafa client
instead of an .exe installer. When upgrading from a Zarafa version prior to 5.10, it
is advised to remove the older Zarafa client before running the new MSI installer.
If the old client is not removed two Zarafa clients will be visible in the Windows
software list.

Version 5.xx of the Zarafa client is not compatible with a version 6.xx Zarafa server.
With version 6.00, Zarafa will ask during the installation if it needs to update the
existing files. Select this option if it’ s not necessary to connect to a Zarafa 5.2x
server anymore.

4.1.1.1. Instructions for Outlook 2003.
Create a new mail profile in Outlook 2003:

1. Go to Control Panel > Mail > Show Profiles---.

2. Click Add--- and fill in a title, for example Zarafa. Click OK.

Add—a Zarafa Server to this protfile: 53
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1. Choose Create a new mail account and click Next in the dialog window that appears after
adding the profile (or after choosing Email Accounts::- in Outlook or the Mail setup).

2. Choose the last option (Extra server types) and click Next > choose Zarafa 6 Server >
click Next.

3. The window shown on the right will appear.
4. Fill in the address or host name of the server in the Server field.
5. Optionally: choose HTTPS connections where available.
6. Fill in the login data of the user in the Username and Password fields.
7. Choose the connection type, there are 3 different possibilities:
+ Online
+ Cached Zarafa mode

+ Detect at Startup

More information on the three connection types can be found in %f 4.2 7
“Outlook connection type” .

8. Choose 0K a couple of times to close the windows.

4.1.1.2. Instructions for Outlook 2007 and higher
1. Go to Control Panel > Mail > Show Profiles:---

2. Click on Add--- and fill in a title, for example Zarafa. Click OK.

3. Select the option Manually configure server settings or additional server types and
click on Next.

4. Select Other, and choose Zarafa Server and click Next.

5. Fill in the address or host name of the server in the Server field.

6. Optionally: choose HTITPS connections where available.

7. Fill in the logon data of the user in the Username and Password fields.

8. Click Ok. The personal folders of this user and the public folders will appear as store
in Outlook after adding the server in this way.

9. C(Click Finish to finalise the profile.
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Start Outlook

The Zarafa account has to be the default account in the Outlook profile. It’ s not

possible to have the Zarafa account as secondary account and use as primary account
for example an IMAP account.

4.1.2. Start Outlook

1. Start Outlook and make sure the added profile is being used.

2. This can be set in Control panel > Mail > Profiles--- on the bottom of the dialog
window.

3. The private mailbox of the entered user and the public folder will appear as a store in
Outlook.

4.2. Outlook connection type

By default, Outlook has an ongoing connection to the Zarafa server and does not store the
folders and items on the local hard drive. With the introduction of Zarafa 6.00, it is
possible to synchronise all private Outlook data to the local hard drive. Email, agenda
and contacts can easily be accessed even if no connection to the server is available.

This functionality is only available if the offline storage is enabled (see the connection
types below) .

The following three options are available for the connection to the server: Online, Detect
at startup and Cached Zarafa mode. These will be described in the sections below.

4.2.1. Online

The Online type works the same as in the previous versions of Zarafa. When a network
connection to the server is available, Outlook can be started. Whenever the connection to

the server is not available email, agenda and contacts can not be accessed.

4.2.2. Detect at startup

With the Autodetect Offline / Online type Outlook checks at startup if the server can be
reached. When Outlook has a connection to the Zarafa server all items will be synchronised
to the offline storage. When the connection is lost, Outlook will not automatically

switch to its offline storage. In order to switch to offline storage, Outlook needs to be

restarted.

When Outlook is started and there is not a network connection available, Outlook will show
a pop-up message which asks if it is wanted to work offline.

Whenever the “ Detect at startup ” mode decides to work offline, the behaviour
for that session will be as described below in 5 4.2.3 1 “Cached Zarafa Mode” ,
effectively. In case it decides to work online, the behaviour of that session will be

E=

as described above in % 4.2.1 7 “Online” .
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4.2.3. Cached Zarafa Mode

The third type of connection is Cached Zarafa Mode. This type is similar to the caching
mode of MS Exchange. If this type is selected, the offline storage will always be used.
When there is a network connection available all items of the user's own store will

be synchronised to the offline storage. The first time the Outlook profile is being
configured it is required to have a connection to the Zarafa server. After the profile is

created and Outlook can be started, all folders and items will be synchronised.

Please consider the limitations of the use of offline storage as described in
# 5.1.2 7 “Limitations of working offline” .

4.2.4. What is the best connection type to choose?

%E 4.1. Connection type options

Type of user ZLarafa profile type
User that always works on the same fixed PC in the office Online
User that uses roaming profiles and logs in on different Online

fixed PC’ s in the office

User that works with a fixed PC remote from a sub department Cached Zarafa Mode
over a small bandwidth internet connection

User with a laptop that is inside the office most of the time |Detect at startup

User with a laptop that is always out of the office Cached Zarafa Mode

User that works on a Terminal Server Online

4.3. Advanced configuration

Since version 6.20 two new settings are introduced in order to improve connection to the

Zarafa server.
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Proxy settings

Zarafa Dutlook Sharing x|

General Connection | Advanced

— Prosy
v Use prosyseryer

Proxy zerver I[

Part IB':'B':I

Uzername IfD:':

aseanne

Pazzword I

— Connection

¥ Use compression

|3EI Seconds ntl Server Connection bimeout

0k I Cancel Apply

4.1. Connection settings

4.3.1. Proxy settings

If the zarafa server is only reachable via a proxy server it is possible to enter the
information of the proxy server into the client settings.

4.3.2. Other connection settings

Two other connection settings are configurable:

Compression: Uncheck this option if compression is not wanted. This option is on by
default.

Server connection timeout: Depending on the connection quality it is possible to change

the timeout to the zarafa server. Default is 30 seconds.

4.4. Public Folder Favourites

To have a useful shortcut to the most used public folders use the Favourite folder that
can be found under the public folders tree. In order to add a folder to the Favourite
folder, right click on a public folder and select Add to Zarafa favourite folder. In
Outlook 2007 the Add to Favourites window will appear. In Outlook 2003 the shortcut will
be added directly in the favourites folder.

By default only the selected folder will be inserted in the favourite folder — without its

subfolders. It is necessary to specify otherwise.
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i Add to favorites

Public folder name

| Very Important |

Cancel

Favorite folder name

| Very Important |

Subfolders
Add subfolders of this folder
) Add immediate subfolders anly
(&) add all subfolders

4.2. Add to favorites window (Office 2007)
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Using Outlook

The Zarafa Windows Client does not change the way one works with Outlook significantly.
However there are some extra features available to those using Outlook to connect with a
Zarafa Server.

5.1. Working offline

After starting Outlook in Cached Zarafa mode or Detect at startup mode additional
synchronisation features will be available in Outlook. For instance: the Synchronise

button on the toolbar, which shows a progressbar during the synchronisation.

Inbox - Microsoft Outlook

: Flle  Edit Wew Go Tools  Actions

(i | Synchronizing. . 8 Configure ! j_!

Favorite Folders ar

| L7 Inbox |

K| 5.1. Synchronisation plugin buttons

The synchronisation time can be scheduled by using the configure button.

When synchronisation is started for the first time, the Global Address Book will be

synchronysed first.

After the Global Address Book has been synchronised, the Inbox will be synchronised. The
most recent emails will be synchronised first.

During the initial synchronisation new email will not be received. New email will be
retrieved after the first synchronisation is finished or after Outlook is restarted during
the sync. Sending new email during synchronisation, however, will be done immediately.

5.1.1. Sending email during offline use

When email is sent during offline use, the email will be kept in the Outbox. To send the
email when the connection to the server has been reinstated, the Send & Receive button has
to be selected.

This action can be scheduled by configuring the Send & Receive settings:
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Send/Receive Groups

8 SendfReceive group contains a collection of Outlook accounts and
folders, You can specify the tasks that will be performed on the group
during a send|receive.

£
2]

Group Mame Send/Receive when

ounks Cnline and Offline

Setting for group "All Accounts"

Include this group in send/receive (F9).

Schedule an automatic sendjreceive every | 1 > J minukes,

[JPerform an aukomatic sendjreceive when exiting.
when Outlook is OFfline

Include this group in send|receive (F3).

5.2. Send and receive settings

5.1.2. Limitations of working offline

Things to consider when using “Offline” functionality:

+ Currently it is not possible to synchronise the favourite folders of the Public Folder

or delegate mailboxes.

+ Public Folders and delegate mailboxes will be directly opened from the server,

Online Zarafa modus, and are thus not available while working offline.

- The synchronisation of a mailbox of 1000MB will take around 1 hour whith a 100Mb/s

network connection to the Zarafa server.

+ In Offline mode it is not possible to open shared mailboxes or set security permissions

on folders.

- In a Cached Mode profile the button Open other user’ s folder is disabled.

+ Currently, shared mailboxes and calendars can only be opened via the button Open shared
folders or via the button Open a shared calendar in the calendar section of Outlook.

- If it’ s not possible to open the Public Folder after being offline, the session is not
available on the server. To open the Public Folder again,

Outlook to set up a new session.
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Folder Management

5.2. Folder Management

5.2.1. The creation of a public folder

By default, every user is able to create folders and items in the Public folders. However,
the permissions on these new items are set so that a new folder can only be read by other

users.

To enable others to write to the folder, the correct permissions must be set; for example
allow writing and deleting by the group Everyone. (See Sharing of folders).

5.2.2. Sharing of folders (setting permissions)

The permission structure has been built with flexibility in mind. It is possible to set
permissions per folder. Every folder inherits the permissions of the folder it is located
in. Every item inherits the permissions of the folder it is contained in.

Before a folder can be added and viewed by other users, the permissions have to be set

correctly.

To accomplish this, right click on a folder and choose Properties.

All Mail Folders (=1 Moah Test
: 1"
=1 6 Inbo - Klaas Test M

(& Deleted Trems i< Moah Test
(7 Drafts Fd: Yuhooo! !

3 Elas 1=
(@l Open :

LEI 9 COpen in Mew Window

=55 i b
L'.j,S LinE Co E

5 Publi Advanced Find. .,

| Properties

5.3. Folder properties button
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Inbox Properties
Genersl I Harme Page I Autodrchive  Permissions |
Marne: Permission Lewvel:
add... Remoye |
— Permissions
Profile: I j
[ Create items [ Faolder permissions
I Read items I Folder visible
[~ Create subfolders
Edit items ———— Delete items
" Mone " Mone
= Own " Own
ol oal
QK Cancel Apply

5.4. Set folder permissions

In the appearing dialog window different settings can be chosen, regarding the properties

of the folder. The last tab window contains the permissions settings.

At the top is a list with users and the permissions which have been set. After selecting a
user the rights can be selected at the bottom. Choosing a profile from the drop down list
makes this easier by automatically selecting often used settings.

Users can be added and deleted with the two buttons below the user list.

For example, to give user Pete the rights to read and write to items in a folder, first
click Add---. After selecting Pete and clicking OK, Pete will show up in the list. After
this the right checkboxes can be set; to enable reading and writing only set Read items
and Edit items on All.

* 5.1. Explanation of permissions

Permissions Description

Create items The user can create items

Read items The user can read items

Edit all items The user can edit all items

Edit own items The user can only edit their own items

Delete all items The user can delete all items

Delete own items The user can only delete their own items

Create subfolders The user can create subfolders

Folder visible The user can view the folder

Folder permissions The user can change permissions on the
folder
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Adding or opening folders shared by other users

If there are no check boxes selected for a user, then denying permissions are in effect
and the user can not access the folder. When no permissions are set on the folder, the
folder one level higher is checked for the set ACLs.

Permissions that apply to the user are cumulative, meaning that the user will receive
the sum of the permissions that apply to his or her user account and groups of which

the user is a member.

By default a user only has read/write permissions on their own folders and is able to
create folders in the Public Folders.

The owner is saved with every item. This way, depending on the set permissions, a user is
only allowed to delete their own items and not items belonging to other users. The owner
of the mail box can always edit or delete all items in his/her mail box, regardless of the
owner of the items.

It is possible to give administrative rights to users, after which they have access to the
entire Zarafa system. These administrators have the ability to change the permissions on
public folders and the folders of each user on the system. Also, every folder or item can

be opened by an administrator.

5.2.3. Adding or opening folders shared by other users

To add shared folders of other users and to be able to write to or read from it, the

following steps should be executed:

1. Click in Outlook on File and Open Shared Folders---.

Outlook Today - Microsoft Outlook

‘| Eile | Edit  Wiew Go Tools  Actions

Mew (38 = | e
iz
; open [
: l  Open chared Folders...
: - - ko [

Close all Ikems

Folder r

Data File Management. ..

5.5. File menu

2. Choose in the dialog window the user and the type of folder to be opened, then click
OK.

Folder of other user

x|
zername: I j
=

Foldertype: I

Cancel |

5.6. User and folder selection
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If Inbox is chosen (permanent), then not only a folder will be opened but an extra mail
box will be added in the folder list of Outlook. This folder will appear in a separate
Outlook window with the folders described as (temporary).

It is only possible to read or write to this folder after the owner has given the rights

to do so. See the previous paragraph about setting permissions.

5.2.4. Adding or removing complete stores of other Zarafa users

In order to delete mail boxes (also called stores) which were added to the list of mail
boxes in the folder 1ist of Outlook, the user must do the following:

1. Click with the right mouse button on a mail box:

[ Inbo Advanced Find. ..

Benarne "Inboc - Robbert T

[g Jurk] ad

Lo Mobel g Mew Folder..,

L:| Sent &dd ko Favorite Folders
_éj Task| Process All Marked Headers
@G
,H L-a S_ear Process Marked Headers
= £ Public fo
[ Favg Open Outlook Data File. ..
O3 Publi| 2= - .
LY
[-—4 Mail

—|§—‘ Properties For "Inbox - Robbert Monna®,..
“Efﬁ ] e e TT

5.7. Folder Properties selection

2. Select Properties > click Advanced-:- > select the tab Advanced in the Zarafa server
dialog window.
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Searching in Outlook

Zarafa Outlook Sharing

General Advanced

— MailBox

Add |
Remaove |

k. I Annuleren Toepassen

5.8. Zarafa server dialog
3. C(Click Remove to remove or Add to add a mail box.

After clicking Add, select a user to add his/her store and let the store appear in the
folder 1list of Outlook.

5.3. Searching in Outlook

A search executed in Outlook will query the database of zarafa-search (zarafa-indexer in
Zarafa 6.40.x - 7.0.x). To enhance the search results Outlook will divide certain words in
individual tokens, depending on the language set in the language bar of Windows.

For example: searching for the word Sauermann or Dauermann in a German system. These words
will be split into mann and Sauer/Dauer. In a Dutch system the name Timmermans will be
split to mans and Timmer.

To only search for the whole word the search-term has to be endorsed in angle brackets ( <
and >) .

The same accounts for hyphenated words like part-time. Searching for this will give
all results matching either part or time. Only searching for <part-time> will give
only results matching both words.

5.4. Restoring deleted items

Because Zarafa uses a so-called Soft Delete system, items removed from view in Outlook can
still be restored. This can be done by selecting Tools > Recover Deleted Items.
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=0l x|

P Recover Deleted Items
Delete | % Messages " Falders
Subjeck I Deleted On I From I Received I

5.9. Recovering deleted items

Select the items which need to be recovered and click on the Restore button to restore the
items to the folder they were deleted from. Most items will be restored to the Deleted
Items folder.

If Delete is selected, the items will be truly removed from the server, and these items
can no longer be recovered. The server has a lifetime on these items, so after a set

period of time, the items will be removed.

5.5. Free/Busy updates

When new appointments are created in the calendar, the Zarafa client will update the Free/
Busy information. This update will occur some time after the appointment was saved or
when Outlook is closed. Other users will not directly see this change in their Free/Busy

overview.

When an appointment is created, it is possible to invite other people. If other users are
added, the overview will be updated to show the Free/Busy times of the user, making it

easy for the organizer to plan the new appointment.

To use the Free/Busy times, the Public Store on the Zarafa server must be available. All
the Free/Busy times will be stored in an invisible folder in the Public Store. If a user
did not yet login with Outlook or Webaccess and did not create an item in the calendar,
the Free/Busy times will not be available.

5.6. Resources

With the resource feature the availibility or scheduling of meeting rooms, beamers, cars
or other objects with limited availability in the company is made easy. Resources are
allocated through meeting requests.

The following steps show how to allocate a resource:

1. Create a new appointment in Outlook.

2. Open the Scheduling tab.
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Resources

| Untitled - Meeting R W— —— [E=TE )
_IEW !I‘I‘S‘EI‘[ Format Tools Actions Help
Send | = i ca B( | 47¥ Recurrence... @Cancei}:_wita‘kion | ¥ B x | Qﬁ | @) !
‘__?—J Script Editor | @Applic&iion [7] Inspector @HTMLEditcr B WordEditor | ¥ Currentltern | (¥ IMessage E
‘Appointment I Scheduling |
Zoom: 5100% {Day View) |z| ‘eptember 18, 2007 Wednesday, September 19, 2007
------------------------------------------------ 10:00 11:00 12:00 1:00 2:00 3:00 4:00 5:00 9:00 10:00 11:00 12:00
All Attendess S s - ] S |
Hol I I - (]
= || || I (i
i
] [ 1
[ Addothers ] [ Outions ] Meeting start time: | Tue 9/18/2007 || [00eM  [+]
|| [ == || AutoPickMextzz | meetingendtme: |Tue 5/18/2007 [=] [#00em  [+]
MW Eusy B Tentstive B outofoffice [N Mo Information

5.10. Free/Busy information
3. Add the name of the resource or select the resource from the Global Address book.

4. Change the icon Required attendee to Resource or Equipment.

All Attendees
Hep & -

H@E -

I+ JRequired Attendee

& Optional Attendee

¢ Resource (Room or Equipment)
T

5.11. Select the option Resource
5. Add the other attendees, that will attend the meeting.
6. Select a free timeslot via the freebusy times and send the meeting to the attendees.

7. If the resource is available in this timeslot, a pop-up will show that the resource is

successfully booked.

Resources Booked

The resources for the meeting were successfully
booked.

[ Please do not show me this dialog again

——

5.12. Pop—up after the resource is successfully booked

8. If the resource is unavailable, a different (free) timeslot needs to be selected.
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When an all day event is planned, please make sure the appointment is booked as Busy
or Out of Office. By default, all day events are set as free and because of that not
visible in the freebusy information.

5.7. Out of Office Assistant

1. Make sure the currently opened folder belongs to the store for which an auto-respond
message needs to be set.

2. Click in the menu of Outlook on Tools, click Out of Office Assistant.

3. In this dialog window an auto-respond message can be set and the auto-responder can be
activated or deactivated.

The first time Outlook is restarted, it will produce a pop-up asking if the auto-respond
message should be disabled again.

This message is the same as the one that can be set with the Webaccess.

5.8. Rules

Select the Inbox folder for which a rule needs to be created, and click in the menu of
Outlook on Tools and select Rules and Alerts. Here it is possible to create rules which

are processed on the server when a new email arrives.

which condition{s) do wou want to check?
Step 1: Select condition(s)

with
[ | from people or distribution list

[ through the specified account

[ ] sent only ko me

] wahere ry name is in the To box

[ 1 marked as importance

[ ] marked as sensitiviky

[ Flagged For action

[ ] wihere ry name is in the Co box

] where ry name is in the To or Co box

[ | wihere my name is nat in the To box

[] sent to peaple or distribution list LI

Step 2: Edit the rule description (click an underlined walug)
apply this rule after the message arrives
with SPAM in the subject
and on this machine anly
move it ko the Ongewenste E-mail Folder

Cancel < Back I\I Mext = I Finish
&)

5.13. Rules wizard
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There are certain limits to the types of rules that can be made. The condition of the rule
can be in any form.

When using Outlook 2003 or 2007, any rule created will automatically have an option
called on this machine only. This option needs to be removed so the server can execute
this rule.

It is only possible to copy/move or to delete a message. These rules can be created, but
they will not be executed on the server. An example of such a rule is to send the mail to
the printer, or forward it directly to another email account.

Local rules can still be performed manually by clicking on the Run rules now button in the
Rules and Alerts dialog.

5.9. Signatures

Signatures can be set in the Options menu of Outlook. It is important to note that
signatures set in Outlook are separate from those set in the WebAccess. It is neccesary to

set the signature in both clients separately.

5.10. Signing and encrypting messages
Since Zarafa 6.10 it is possible to use S/Mime certificates. Certificates enables the use

of digitally signing emails and/or encrypting emails.

The description in this manual is the manual procedure. An automatic way to receive
a certificate is to use Active Directory Services (ADS). The automatic method is not

described in the client manual, but will be described in the server manual.

5.10.1. Retrieving a certificate

In order to get a certificate a registration at a Certificate Authority (CA) is needed.
Multiple possibilities are available; one is to have the Active Directory (AD) act as a
CA, the other is to subscribe to an independent CA, like CaCert (http://www.cacert.org/).

5.10.1.1. Certificates via AD

The company’ s AD is configured to act as a CA:
1. Open Internet Explorer

2. Go to the following URL: http://<domainserver>/servcrt. If the URL is different, ask
the systems administrator for the correct URL.

3. Click on Request a certificate and on the next page on User Certificate to generate a
certificate.

4. The certificate will be placed into Outlook automatically.

.10.1.2. Certificates via an independent CA
Go to the site of the CA.

= o
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2.

10.

11

12.

13.

Register the email address and create a certificate.
Use Firefox to retrieve the certificate.

In Firefox, go to Tools > Options > Tab Advanced > tab Encryption > button View

Certificates.

& Certificate Manager ' - 10| x|

Vour Certificates | Feople I SErvers I Authorities I Others I

You hawve certificates From these organizations thak identify wou;

A

Certificate Mame | Security Device | Setial Mumber | Expires On I_'rI
[= Rook C&
: Cacert WoT User

Software Securit... 05:05:04

Chacert WaT User Software Securit... 05:04:53

Chcert WoaT User Software Securit... 05:03:46 2008-10-21

Chcert WaT User Software Secarit... 04:F0:07 2008-10-05
Wigm... Backup... Backup All... Impaort... Delete...

Ik

5.14. Certificate Manager

Select the correct Certificate and Click Backup.
Enter a password.

Save the certificate as a PKCS12 file.

Open Outlook.

Go to Tools (if Outlook 2003: Options) > Security Tab > Click Import/Export--- > Click
Browse--*

Select the correct .P12 file.

. Enter the previous password.

Enter in the field Digital ID Name: the email address for which the certificate is

meant.

Click button OK twice.

5.10.2. Check encrypted email settings

1.

2.

Go to Tools > Options > Security tab > click Settings---.

Check if the field Security settings Name: contains the S/MIME settings for the email
address.
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Using the certificate

Change Security Settings ﬂ

Security Setting Preferences

Security Settings Mame:

| My S/MIME Settings (user@zarafa, com)

Cryptography Eormat: IS,l'MIME

W Default Security Setting For this cryphographic message Format
[ Default Security Setting For all cryptographic messages

Security Labels. .. | Mew Delete | Passwatd. .. |

Certificates and Algorithms

Signing Cettificate: IC.ﬁ.cert WoT User's Fook Ca 1D #4 Chonose. .. |

Hash algorithm: ISHM j
Encryprion Certificate: IC.ﬁ.cert WoT User's Fook Ca 1D #4 Chonose. .. |
Encryprion Algorithnm: ISDES j

[v send these certificates with signed messages

QK I Cancel

5.15. Security Settings

5.10.3. Using the certificate

After entering the certificate into Outlook it can be used to digitally sign outgoing
emails or receive encrypted incoming emails.

When a new email or reply is opened two new icons will be present: #: (the option

to digitally sign messages) and i (the option to encrypt the message contents and

attachments) .

5.11. Fax Feature

Since version 6.20 it is possible to send fax through Outlook 2003/2007 and a third-party

software such as Hylafax.

In order to send a fax:

—

Open the new e-mail window by clicking the File menu, selecting New and Mail Message.
2. Go to Options, Format and choose Plain Text.

3. Fill in the To: field with the following syntax [fax: <fax number>], where <fax number>

is replaced with the actual phone number of the fax machine.
4. Fill in the From: and Subject fields as they will appear in the fax cover.
5. Enter the mail body as for a normal mail message

6. Click Send
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Untitled - Message (Plain Text) R

33 =1 L
| Request a Delivery Receipt ‘g &
| Req v Receipt =3 i

I
Use Voting ™ Request a Read Receipt ! save sent Delay  Direct |
Buttons~ Item - Delivery Replies To |

&
3
@
$
<

Message Insert

EColors = E

.Fonts =
Page
[O]Etfects - | Color -

l I
(s Aa Rich Text |
Il

Themes Il Fields El Format Tracking | More Cptions M |
This message has not been sent. Plain Text

[ To l ﬁfax'ﬂﬂSllZEHSGHj Format this message as plain text. |
= [ cc... ] | Plain text can be read by everyone |

Send but contains no formatting.
Bec.., l | |
Subject: | |
|

5.16. New fax item

To be able to send fax messages, an administrator needs to install software or adjust
settings on the server. Additional information for administrators can be found on the

09 o o 9 . 1
wiki article Fax server integration .

5.12. Delegation

Since Zarafa 6.20 two kinds of delegation are available: Send on behalf and Send as. In

earlier versions, only Send on behalf is available.

5.12.1. Send on behalf of permissions

Send on Behalf permissions: if a user grants the appropriate permission to another user,
the latter can send items on behalf of the other user. In this case an email or meeting
request will be sent showing it was on behalf of the other user. The recipient will see
in the From: field something similar to ‘ <delegate> on behalf of <user> ' . For example
Pete enters the inbox of info and sends an email on behalf of the non-active user info,

the following would be seen:

pete@example.com on behalf of info@example.com.

The option to add delegates is available in the Options menu of Outlook, as seen in
5.17 “Zarafa delegates”

! http://zarafa.com/wiki/index.php/Fax_server_ integration
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Send as

Options

| Preferences || Mail Setup || Mail Farmat || Speling || Securiby || Other | Zarafa Delegates

Delegates can zend items on pour behalf. To grant permiszion to others to access
wour folders without alsa giving them send-on-behalf-af privileges, go to properties
for each folder and change the options on the Permizsions tab.

Luiz Test Add...

Remaowe...

Fermissions. ..

5.17. Zarafa delegates

5.12.2. Send as

Send As permissions: the system administrator can grant permission to user B to send as
user A. The recipient(s) will not see that user B actually sent it; only user A appears
in the From: field. See the Administrator manual on how to grant Send As permissions to

users.

E.‘ Untitled - Message (Rich Text)

© File Edit | Wiew | Insert Format  Tools  Ackions  Help

fi=dsend | 4 Previous LB s - PR S 1|"F|2§} 2] Options... |'ﬁ_~1._‘llnﬁ|~_)!

-E

_!l-h

-n-

: Al Next ‘A B 1 ouF]

 From Field

From. .. Bcc Field
To... @ Options, ..
CC... ¥

Subjeck: I

5.18. Show From: field in new email

Due to security reasons the send as permission is only configurable by the
administrator on the Zarfa server. However, this setting can always be overruled by
the user itself and the old on behalf of permission can still be set by the user.
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If the (bounce) message below is returned when sending an email on behalf of, please
contact the systems administrator.

You are not allowed to send as the given user.

W

Due to the introduction of the Send As permissions in Zarafa 6.20 the previous

abilities to send on behalf of are reset when upgrading to version 6.20 or higher; an
administrator or the user who wants to delegate has to give the rights or permissions

again.

Keep in mind that Send on Behalf permissions always overrules Send As permissions so a
user can always choose not to let another user (mis)use send as permissions.

5.13. Categorisation

Since version 6.20 it is possible to categorise the items in Outlook by default categories
and by customized categories.

5.13.1. Create a custom category in Outlook 2007

1. To create a custom category, click on the Categorise button in the Outlook toolbar and
choose All Categories.

2. The Color Categories window will appear: choose New to add a new category.

3. The New Category window will appear; fill in the name of the category, choose a color
to represent it and optionally a shortcut key.

4. Click on OK and the new category will be automatically added to the available
categories in the Color category window.
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Color Categories

To assign Color Categories to the currently selected items, use the checkboxes next to each
category. To edit a category, select the category name and use the commands to the right.

Mame Shortout key [ Mew... ]
] () Blue Category

11 ] Business
[ ][] Green Category [ Delete ]

Halid
DD eaay Colar:

I

[ Rename

][] Orange Category

[ @) Purple Category L 5
F @ Red Category Shortout Key:
11| Yellow Category (Mone) b

[] @ New Custom Category’

K ] ’ Cancel

5.19. Categorys in Outlook 2007

Add New Category |E| rg|

Mame: | |

K 5.20. Add category in Outlook 2007

5.13.2. Create a custom category in Outlook 2002/2003

Open a new mail and choose in the taskbar for options.

—

2. Choose in this window (message options) for categories, and then for Master category

list.
3. Type the name for the new category and add this with the Add button.

4. After creating the category, confirm with the OK buttons in the open windows.
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Message Options

Message settings Security Master Category List
[ena cakegary:
Sensitivity C_T__—__. ___________ I—— |tesl:| | L add J
. . dlegories
YWoting and Trackingl ] Bsingss = e  —
[Juse v Itemis) belong ko these categor Egr;ﬁggu” v
[TReau Gits
Goalsfobjectives
[1Reque Holiday j
Delivery options — _ : Holiday Cards 5  —
Available categories: Hok Contacts
[NHave | m=-— Ideas es
@ __| Business International
Saved | c':'""F“?t't":"" kKey Cuskomer B |
|| Favorites Miscellaneous =
(oo ne| | Gifts Personal
_ || Goals/Objectives Phone Calls
[CIExpire [ Holidary Status .
Attachme | Holiday Cards Strategies )
|| Hok Contacts
Encoding| | L Ideas [ Ok ] [ Cancel ]
|| International
o ot |
|| Miscellaneaus _
| |
[ (8].4 ] [ Zancel ] [ Master Cateqory List, .,
D

5.21. Add category in Oulook 2002/2003

5.13.3. Categorise items and sort by category

In order to categorise an item (it is possible to categorise Mail, Contacts and
Appointments) right click on it, choose Categorise and then click on the desired category.

To order the items by category open the View menu, choose Arrange by or Current View and

then Categories.

5.14. Mail expiration date

Since ZCP version 6.20.0 it is possible to set an expiration date for the outgoing mail.

When writing a new mail, this setting can be found under Options > More Options: the

Message Options window will appear.

Tick the Expires after option and set the expiration date.
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Mail expiration date

Message Options E| |E|
Message settings Security
Importance: a Change security settings for this message.

Sensitivity: [ Security settings...

Voting and Tracking options

@ [ ] Use voting buttons: | i

[ |request a delivery receipt for this meszage

[ ]Rrequest a read receipt for this meszage

Delivery options

%\ [_|Have replies sent to: | | [ Select Mames. ..
[ ] Do not deliver before: | | | |

Expires after: |08/10/2008 v | |17:00 v |
Attachment format: | Default W |
Encoding: | Auto-Select w |

Contacts. .. |

 Close |

5.22. Message options

T
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6

Configure Mail Clients (with IMAP and
POP3)

6.1. Client configuration

Every client supporting IMAP4 or POP3 should be able to connect to Zarafa via the Zarafa
IMAP & POP3 gateway.

For sending mail clients will use SMTP. The SMTP server can be the same as the Zarafa
server or the SMTP server of the internet provider. Some servers need SMIP authentication.
The client can store sent messages in a Sent Items folder.

SMTP credentials are not necessarily the same as the Zarafa credentials.

6.1.1. Mozilla Thunderbird

This manual is based on Mozilla Thunderbird version 2. Other versions can be set up in a

similar way.

The first two steps can be skipped when opening Thunderbird for the first time. The
following example is for the IMAP protocol. The POP3 protocol is practically the same
without steps 10 to 12.

1. Go to Tools > Account settings---.

Tools  Help
Address Book Chrl+2
Extensions

Themes

Message Filkers., ..
Run Filkers on Folder

Junk Mail Contrals., ..
Run Junk Mail Contrals on Folder
Deleke Mail Marked as Junk in Folder

Irmport...
Jawascript Console

Accounkt Setkings. ..

Opkions, .,

6.1. Tools dropdown menu
2. Click Add Account.
3. Select Email account and click Next.
4. Fill in your name and Zarafa email address and click Next.
5. Select IMAP and fill in the Zarafa server s hostname or IP address. Click Next.

6. Fill in the Zarafa username for the Incoming username and the outgoing username. Click
Next.
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10.

11.

12.

13.

The account name can be chosen by the user itself. Click Next.
Check the data and click Finish. Now close the Account Settings window.

Open the Inbox and type in your password to receive the folder structure from the

Zarafa server.

Re-open the Account Settings window and select the Server Settings in the previously

created account.
Set the security to the desired level (default is Never).

Select Copies & Folders in the account tree and set the correct foldernames for the
IMAP server.

Finally, click OK and start using Zarafa with the IMAP protocol.

6.1.2. Windows Mail

This example is based on Windows Mail. Outlook Express can be configured in a similar way.

The following example is for the IMAP protocol. Setting up the POP3 protocol is

practically the same; skip steps 10 to 12.

1.

Go to Tools > Accounts.

Tools  Message  Help

Send and Receive 4

Synchronize All

Address Book, .. Chrl+shift+B
Add Sender to Address Book

Message Rules 4

IMAP Folders. ..

Accounts. .,

Options. ..

6.2. Tools dropdown menu

Click Add:---.

Select Email Account and click Next.
Enter the Display Name and click Next.
Enter the Email Address and click Next.

Select IMAP from the dropdown menu, fill in the Zarafa server s hostname or IP address

and the hostname or IP address of the outgoing mailserver.
Optional: check whether the outgoing server needs authentication and click Next.
Fill in the Zarafa username in Email Username and the Zarafa password. Click Next.

(Un) tick whether the user wants to download the data from the server right away and

click Finish.
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Windows Mail

10.

11

12.

13.

Highlight the new account in the folder 1list and click Properties in the context menu

(open by a right-click on it).

. Select the IMAP tab.

Check whether the Special Folders is ticked and the folders are set the same as the
Zarafa folders.

Finally, click OK and start using Zarafa with the IMAP protocol.
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w7

Configure Calendar Clients (using

CalDAV and iCal)

This chapter describes how to configure the CalDAV or iCal client for using with the

Zarafa server. The zarafa-ical gateway enables users to view their Zarafa calendars using

clients like Sunbird, Evolution or Mac iCal. Since ZCP 6.40 tasks can be synchronised and

created from the different clients.

To access calendar folders on Zarafa the following options are available.

For all clients but the Mac 0OS X iCal client use:

URL
http://server:8080/ical

Calendar

User’ s own default calendar via ical (not
recommended)

http://server:8080/caldav/<user>/<calendar-

name>

’ . 9
User s calendar in user s store. Make

sure the calendar name is in the store.

http://server:8080/caldav/<user>/<subcal>

User’ s self created subcalendar in the
user’ s own store. Location through actual
subfolders in Zarafa is irrelevant.

http://server:8080/caldav/<other-user>/

<calendar-name>

Other-user’ s shared calendar

http://server:8080/caldav/public/<calendar>

Calendar folder in the public folder

http://server:8080/caldav/<user>/

User’ s default calendar. Although this
works for most clients, this URL is not

recommended.

For the Mac 0OS X iCal client use:

URL For Mac OS X iCal client

http://server:8080/caldav

Calendar

User’ s calendar list

http://server:8080/caldav/<other-user>

Other-users calendar list

http://server:8080/caldav/public

Public folders 1list

The format and capabilities of iCalendar and MAPI recurrence types are very different.

The conversion of this information is not always the same, or not even possible at all at

times. Following is a list of known recurring appointment types that cause problems:

Recurrence type

Monthly every day of a week

Description

Convert to weekly every day of the week

Yearly every day of a week in month x

Not supported

The <other user> or <user>/<calendar> is only reachable if the correct permissions

are available. Please make sure the user has not only the appropriate calendar

permissions, but also "Folder visible" permissions on the mailbox of the other user.
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The Mac iCal client is fully tested and supported up to 10.5.6.

7.1. Mac OS X iCal Client

1. Start iCal in Finder: click Go > Applications > iCal.

2. Click iCal from menu and select Preferences.

Services [ .
¥
Hide iCal SeH ||
Hide Others ™C3H
Show All
Quit iCal 2Q |
T—

7.1. iCal dropdown menu

. ‘ 9’
3. Click on + to create new account.
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Mac OS X iCal Client

Description: | UserX |

Accounts

Username: | Userx |

Password:

W Server Options

Account URL: lhttp:”zarafasemr:SDB.D,FcaIdmd I

[ Use Kerberos w5 for authentication
/ account.

(CCancel ) @A)

7.2. Account details
Fill in the details. Add server address as: http://server:8080/caldav/

Click on Add to retrieve the calendars of the user.

Accounts ~——| Mccount Information - Server Settings  Delegation |

@ UserX
77 CalDAV Account

Description: Us:er)d

Username: l Userx l

Password: | ssssses |

Full Name: Calendar - Suyi Guo

Refresh calendars: { Every 15 minutes “

Availability:

Availability is not supported on the server for this account.

7.3. Account created
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7.2. Sunbird Client Guide

1. Start Sunbird client.

2. Click on File in the menu bar and select New Calendar.

3. Select option on the Network. Click Next.

Create Mew Calendar

Create a new :aler{:}ar
Locate your calendar

Your calendar can be stored on your computer or be stored on a

server in order to access it remotely or share it with your friends
or co-workers.

O On My Computer
@ |On the Network |

Cancel | | Next |

b

7.4. New calendar location

4. For iCalendar, select the iCalendar Option. Enter as location: http://server:8080/ical.

Create NMew Calendar

Create a new calendar
Locate your calendar

Provide info about what is needed to access your remote calendar
Format: @ iCalendar (ICS)

O CalDAV

O sun Java System Calendar Server (WCAP)

Location: | http://zarafaserver:8080/ical |

Cancel | | Back || Next |

L
7.5. iCal details

5. For caldav, select CalDav option. Enter as location: http://server:8080/caldav.
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Evolution Client Configuration

Create New Calendar

Create a new calendar
Locate your calendar

Provide info about what is needed to access your remote calendar
Format: O icalendar (ICS)

@ CalDAV

) Sun Java System Calendar Server (WCAP)

Location: | http://zarafaserver:8080/caldav |

Cancel | | Back || Next |

LS

7.6. CalDav details

7.3. Evolution Client Configuration
1. Start Evolution client.

2. Click on menu New. Select Calendar.

3. Fill in the details & remove the Use SSL option. The URL options are similar to
Sunbird.
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e

Calendar

Type:
Mame:

LIRL:

Mew Calendar b4

CalDAV

L]

Isers

caldav:jzarafaserver:8080/caldav

[] Use SSL

Username: |userx |

Color:

[] Copy calendar contents locally for offline operation

|Mark: as default calendar|

7.7. CalDav details
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Configure Mobile Platforms

This chapter describes how to configure the Z-Push software to synchronise PDA’ s and

Smartphones with a server based solution.

Z-Push is available as an opensource project on Sourceforge — http://z-

push.sourceforge.net

&8.1. Z-Push introduction

The Z-Push software allows users with PDA’ s and Smartphones to synchronise their email,
contacts, calendar items and tasks directly from a compatible server over UMIS, GPRS, WiFi

or GSM data connections. The following devices are natively supported by Z-Push:
- Apple iPhone and iPad

« Windows Mobile 5, 6, 6.1 and 6.5

+ Windows Phone 7 and 7.5

- Nokia E/N-series with Mail for Exchange (M4E)

- Nokia E-series with built in ActiveSync (Nokia Mail 2)

* Android Cupcake or Donut with third party tools like Nitrodesk Touchdown

* Android Eclair with Contacts and Calendar synchronization or third party tools

» Android Froyo, Gingerbread, Honeycomb, Ice Cream Sandwich and Jelly Bean using the
default ActiveSync client (Microsoft Exchange ActiveSync type account) or third party
tools

- Blackberry PlayBook
- other ActiveSync compatible devices

The devices can be synchronised because the Z-Push module emulates a MS Exchange
server on the server side, allowing users to synchronise without installing specialised

synchronisation software on their devices.

8.2. Setting up a mobile device

It is simply a case of adding an ‘Exchange server’ to the ActiveSync server list by
specifying the IP address of the Z-Push Apache server, disabling SSL, unless SSL has
already been setup on the Apache server, setting the correct username & password (the
domain is ignored, simply specify domain or some other random string). and then go through
the standard ActiveSync settings.

Once the mobile device has been setup, it should be possible to synchronise the device
simply by clicking the Sync button in ActiveSync.

8.2.1. ActiveSync based configuration

The following steps are made for the Pocket PC, though still applicable for WM 5/6 or
Nokia’ s ‘Mail for Exchange’

1. Open ActiveSync and select set up your device to sync with it.
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i i | ActiveSync oy '7|'|| L H

To sync with a desktop computer, install
ActiveSync on your cormputer and then
connect this device,

If wour cormpany supports syncing directhy
with its Exchange Server you can set up
your device to sync with it

Learn more about syncheonizing with a
SEFVEF,

Sync = Menu

8.1. ActiveSync introduction

2. Type the server address (without http or other URL parts).

ActiveSync

Edit Server Settings 9

Server address:
Iyzerver . domain, com |

Mate: This is the same as your Outlook Web
Arcess server address,

D This server requires an encrypbed (5500
canneckian

Cancel = MNext
8.2. Server address
3. Specify a username and password, a domain must be specified but it is not used within

Z-Push, so simply domain or some other random text can be specified. Select save
password if automatic sync is preferred.
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ActiveSync

Edit Server Settings 9

User name: |user |

Passwaord: |***** |

Domain: | |

Save password
{required for automatic sync)

| Advanced... |

Back = Mext
8.3. Account details

4. Select which items must be synchronised.

f-. Activesync

Edit Server Settings e

Choose the data wou want ko synchronize:
®B) Contacts
Calendar
& E-mail
Tasks

Back = Finish
8.4. Synchronise options

5. Press Finish and start synchronising by pressing Sync.

&8.2.2. iPhone based configuration
The following steps are applicable for the iPhone:

1. Open Settings and touch Mail, Contacts, Calendars.

2. Touch Add Account--- and touch Microsoft Exchange.
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_aaill NL = 14:54 O =

Accounts

GMail
Mail

Add Account...

Mail

Show 100 Recent Messages »
Preview 3 Lines >
Minimum Font Size Medium »

Show To/Cc Label ~ [ilen |
Ask Before Deleting  [len ] |

8.5. Mail, Contacts, Calendars settings

alINLKPN = 15:15 O

mobileme

Cmail

YAaHOO! MAIL
AOL &

Other

-

8.6. Choice Protocol/Provider
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3.

Enter the user credentials, and touch Next.

_all NLKPN = 14:55 O EE

Cancel Exchange

v N
Email john@zustomer.com

r ™
Domain Optional

Username john

Password essescsssse
-

i h
Description john@zustomer.com

8.7. User settings

The device will try to contact the server. If the server is not equal to zustomer.com

in this case,

the connection will fail. If the server is not configured for SSL

connections, the connection will fail too. The iPhone has SSL enabled by default.

A new option field Server will pop up. Enter the correct server address or IP if

necessary.
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aliNLKPN = 14:56 O B

Cancel Exchange

1
Email john@zustomer.com
Server zarafa.zustomer.com

v

™
Domain Optional

Username john

Password esesessssesses

Description john@zustomer.com

8.8. Extra server field

6. If SSL is not available the connection will fail to be established. Touch Save in order
to keep the current account settings. Go to the Jjust created account and touch Account
info and disable Use SSL.
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8.9. Save settings

o send or
uwantio s

_alNLKPN = 14:57 0 ==

ohn@zustomer.com

8.10. Account settings

Email john@zustomer.com
Server zarafa.zustomer.com
Domain

Username john

Password esessssss

Description john@zustomer.com

Use SSL <cdisable>
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